
User’s Guide to the SPOT Cooled Color
Digital Camera

Table of Contents:

Copyright Information ...........................................................................2

Introduction/Document Conventions....................................................3

Ch. 1 - Electronic Imaging Theory and the SPOT Camera .................4

Ch. 2 - Navigating the SPOT Software ................................................9

Ch. 3 - Preparing to Take a Picture....................................................19

Ch. 4 – Taking a Picture.....................................................................48

Ch. 5 - Viewing, Editing and Annotating Images ...............................65

Ch. 6 - Calibration and Measurement ..............................................103

Ch. 7 – Using SPOT Databases ......................................................107

Ch. 8 - Printing Options ....................................................................124

Appendix A - Specifications .............................................................132

Appendix B - Changing the Dessicant .............................................133

Appendix C - Using SPOT's TWAIN Features.................................136

Appendix D - Using the SPOT Image Pro Plus Driver.....................141



Single User Copyright and License Agreement, Diagnostic Instruments
Carefully read the following terms and conditions before using the software.  By using the software
on the enclosed CD, you indicate your complete and unconditional acceptance of these terms and
conditions.

This document is a legal agreement between you, the end user, and Diagnostic Instruments, concerning the
use of the enclosed software.  This agreement constitutes the complete agreement between you and
Diagnostic Instruments.

If you do not agree to the terms of this agreement, do not use the CD.  Promptly return the CD,
including the written materials, the binder, and all other equipment/containers to the dealer where
you purchased them from.  You will receive a full refund.

1. LICENSE:  Diagnostic Instruments grants you the LICENSEE, a limited, non-exclusive license to use
the enclosed software.  You may physically transfer the Software from one computer owned or leased
by you to another, provided that the Software is used on only one computer at a time.  You may not
electronically transfer the Software from one computer to another over a network.  You may make a
copy of the Software for backup and archival purposes, provided that the original copyright notice
an/or other legend is reproduced on each copy.  Except for backup purposes, you may not make or
distribute copies of the Software.  You may not modify, translate, adapt, reverse engineer, decompile,
disassemble, or create derivative words based on the Software.  If you wish to use the Software on
more than one computer, you must license another copy of the software for each computer.

2. TITLE:  Diagnostic Instruments retains title to the Software, subject to your right to possess and use
the software while the License is in effect.  You will agree to use your best efforts to protect the
software from unauthorized use, illegal reproduction, or illicit distribution.

3. COPYRIGHTS and TRADE SECRETS:  Diagnostic Instruments owns all rights regarding the
Software.  This agreement does not convey ownership of the software to you, but only the right to use
a copy of the software strictly in accordance with this agreement.  The unauthorized duplication or
distribution of the software or the documentation is an infringement of Diagnostic Instruments' rights
to the software and may be subject to criminal and/or civil penalties.

4. UPDATE POLICY:  In order to receive updates to the Software, you must complete and return the
enclosed registration card to Diagnostic Instruments.  All updates provided to you shall become part of
the software governed by the terms of this agreement.

5. GENERAL:  This agreement merges all prior written and oral communication regarding the Software
and sets forth the entire agreement of the parties.  This agreement shall be governed by the laws of the
state of Michigan, without regard to the conflict of law provisions thereof, as if it was performed
wholly within the state.

Copyright and Trademark Information
Copyright 1997-1998 by Diagnostic Instruments, Inc.
All rights reserved.

Trademarks:
SPOT is a registered trademark of Diagnostic Instruments, Inc.
Windows 95 and Windows NT are registered trademarks of Microsoft, Inc.
Adobe Photoshop is a registered trademark of Adobe Systems Incorporated.

All other product names mentioned in this document are the property of their respective trademark holders.
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Introduction
This on-line manual contains instructions for using the software that comes with both the
standard SPOT Cooled Color Digital Camera and the SPOT 2 slider version of the
camera.  The Adobe Acrobat Reader allows you to use the manual in a variety of ways.
You can view all or selected parts of the manual on-line, or you can use the Acrobat
Reader to print exact copies of what you see on the screen.

Document Conventions

The following table details the specific textual conventions that are used throughout the
manual:

Notes ! Note:  This is an example of a note.  Notes appear
within the text to indicate information for further
consideration or reference.

Cautions CAUTION!
This is an example of a cautionary note.  Cautionary
notes appear to indicate that you should carefully
consider the implications of an action.

Warnings MWARNINGM

THIS IS AN EXAMPLE OF A WARNING.  WARNINGS
INDICATE THAT THE ACTION YOU ARE TAKING COULD
EITHER CAUSE INJURY TO YOURSELF OR COULD
HARM YOUR SYSTEM

Links All chapter headings are linked to their locations within
the chapter.  In addition, certain references to other
chapters and sections are linked for convenient
reference.

SPOT2 SPOT2 SPOT2 notes indicate specific instructions for
users with the slider version of the SPOT
camera.  Unless otherwise indicated, all
instructions apply to both versions of the
camera.
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Introduction
This chapter is a brief overview of the operational theory behind the SPOT Cooled Color
Digital Camera. The next two sections, Digital Photography and Color Images provide a
short introduction to electronic imaging theory, followed by a description of how this
theory applies to the SPOT camera.  The final section highlights some of the unique
features of the SPOT camera.

Digital Photography

Modern electronic imaging is based on the charged coupled device (CCD).  All of
today’s digital cameras have a CCD chip or chips.  In digital cameras, the CCD chip/
sensor replaces the film of traditional cameras as the means by which the camera records
the image. The surface of the CCD chip is composed of light-sensitive cells arranged in a
checkerboard pattern.  Each cell of the checkerboard is known as a picture element, or
more commonly, a pixel.  The following is a simplified description of what happens when
you take a picture with a digital camera:

1. The camera’s optical system forms images on the “checkerboard” of pixels.

2. The CCD is exposed to the image for a period of time.

During this period, each photo-sensitive cell receives photons of light, converts the
photons to electrons, and then stores the electrons in the cell.  The process by which
each cell accumulates electrons can be compared to a well filling with water.  As
more light hits a cell, the electron level in the well rises.  The more electrons that are
in the cell, the more voltage it will have when read out by the digital camera.

3. Following the exposure, a digital camera does three things:

a. It measures the voltage of each cell.

b. It converts the voltage to a binary number.

c. It transmits this number down a cable to your computer.

4. The computer reconstructs the image by assigning a brightness value to each pixel in
the final image.  Each brightness value is proportional to the voltage of the
corresponding cell on the CCD chip.
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Color Images

Because a CCD chip is inherently monochromatic (i.e., black and white), color filters
must be used to extract the color information from the image.  There are three basic
design methodologies:

§ Single CCD design using color masked pixels - Digital cameras designed in this
manner have one CCD chip with color filters physically bonded to each pixel on the
chip.  Some pixels get red filters, some pixels get green filters and some pixels get
blue filters.  Since each pixel is only able to measure the intensity of one color, the
intensity of the missing two colors for this pixel must be estimated, based on nearby
pixels that have precise measurements of the missing colors.  For example, a pixel
that has a green filter will have an exact measurement of the green color value, but
the red and blue values must be estimated, based on the nearest red and blue pixels.
This estimation is known as interpolation.

Pros and Cons: A digital camera designed in this way is inexpensive and can freeze
moving images with a single exposure.  However, because they interpolate brightness
values, such cameras tend to produce images where the fine details are smeared; they
cannot provide the high resolution that is available from a non-filtered CCD chip.

§ Three CCD design using color beamsplitter - This design uses  three CCD chips.
The incoming image first goes through a color beam splitter which directs the red
light to one chip, the green light to a second chip and the blue light to a third chip.
The chips are very accurately aligned so as to achieve near perfect registration
between the three chips. The red, green, and blue values for each point on an image
are measured by the corresponding pixel on each of the three chips.

Pros and Cons: This design produces an image that retains the high resolution of the
individual chips.  This type of camera can also freeze moving images with a single
exposure.  However, because most of the cost in a high resolution CCD camera is in
the CCD chip itself, three chip cameras are far more costly than their single chip
counterparts.

§ Single CCD design that takes three pictures (three pass method) – Cameras
designed in this way expose a single CCD chip three times, once to red light, once to
green light, and once to blue light.  One variant in this type of camera is how the chip
is exposed to the different colors of light.  Some cameras switch individual red, green
and blue glass filters in front of the chip for each exposure.  Others use a liquid
crystal filter that changes from red to green to blue as different voltages are applied to
it.  By exposing the chip three times, each cell on the CCD is able to measure all three
color values.

Pros and Cons: This technique attains the high resolution of the three CCD design
without the high cost associated with using three chips.  However, because these
cameras require three exposures, they cannot freeze moving images.
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The SPOT Cooled Color Digital Camera

In order to provide you with an understanding of what happens when you take a picture,
the following sections highlight some of the basic operating principles of the SPOT
camera.

Three Pictures

The SPOT camera uses the single CCD, three pass method.  To take a picture (also
known as capturing an image), the SPOT camera takes a red picture, a green picture, and
a blue picture.  A color filter, controlled by the software that accompanies your camera,
changes from red to green to blue for each exposure.  Thus, SPOT can use one CCD chip
to compute precise red, green, and blue values for each pixel in the final image.

Pixel Digitization

Following each exposure, SPOT reads the CCD chip and digitizes each pixel as it comes
off of the CCD chip, and before it is sent through the cable into the computer.  This
technique minimizes noise and maintains the lack of distortion that is inherent with CCD
chip geometry.

A Cooled CCD Chip

The CCD chip in the SPOT camera is cooled in order to reduce thermal noise.  The effect
of thermal noise on a digital image is similar to the "snow" that you see on your TV when
tuned in to a station with a weak signal.  If you could reduce the snow (i.e., the thermal
noise), the weak station (or the dim image) would be much clearer.  Cooling the CCD
chip cuts the amount of thermal noise in half for every 5°C drop in temperature.  The
SPOT camera uses a Peltier thermoelectric cooler to keep the chip cooled to 37°C below
ambient room temperature.  Thus, if the room temperature is 25°C, the CCD chip is
12°C.  This makes the SPOT camera an excellent option for dim images.

! Note: In order to keep the CCD chip from frosting over, a desiccant packet is added
to the air space surrounding the chip before the camera is sealed.  Over time, the
desiccant can become saturated with moisture and lose its effectiveness.  To change
a desiccant packet, refer to Appendix __.

Gain

Normally an auto exposure routine in a digital camera sets the exposure time so that the
brightest pixel on the CCD chip is completely “filled” with electrons, or is “full well”
(see the Digital Photography section).  This simple technique works well for bright
images, but, as an image gets dimmer, exposure times can get uncomfortably long.
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With the Spot camera you can shorten exposure times by filling the brightest pixel on the
CCD to less than full well, and then using this lower level as full scale.  The inverse
fraction of full well that the brightest pixel on the CCD is filled to is known as the gain.
For example, filling a pixel to half of full well cuts the exposure time in half.  Since the
exposure time is cut in half, we call this a gain of 2.

The following table illustrates the relationship between gain, the fraction of full well that
the brightest pixel is filled to, and the effect of gain on exposure time:

Gain Fraction of Full Well Exposure Time (sample)

1 1 80 seconds

2 1/2 40 seconds

4 1/4 20 seconds

8 1/8 10 seconds

16 1/16 5 seconds

An 80 second exposure at a gain of one turns into a 5 second exposure at gain 16.  This is
good in terms of the exposure time.  Unfortunately, background noise is directly
proportional to gain.  It is 16 times higher at a gain of 16 is than at a gain of one.

An Automated Exposure Process

Normally, for any given image, trial and error would have to be used to determine the
optimal combinations of gain and exposure time.  In order to eliminate the need for trial
and error experimentation, the SPOT camera automatically determines this information
by sampling light levels before each exposure.  Based on the light levels and the user-
determined Auto-Gain Limit, SPOT determines the optimal gain setting and exposure
time for the image.

! Note:  For more information on using the Auto-Gain Limit feature, refer to the
Chapter 3, “Preparing to Take a Picture.”
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Introduction
This chapter is an introduction to the SPOT program's operating environment.  It consists
of three major sections:

§ The Viewing and Editing Window - This section describes the primary window for
all image capture and editing functions.

§ Opening and Saving Files - This section discusses the standard Windows file save
and open features, as well as those that are unique to the SPOT program.

§ Preliminary Settings - This section describes the initial settings that you can make to
customize your software.

The Viewing and Editing Window

When you open or capture an image, it appears in the main viewing and editing window.
All of the image save, view, edit, and annotation functions are accessed from this
window, which consists of three areas:

§ Menus

§ The Toolbar

§ The View Status Bar

Each of these areas is discussed in the three sections that follow.

Menus

The menus that appear at the top of the window vary according to whether an image is
open, and whether you are editing or annotating an image. When you first open the
software, the only functions that are available are the file opening, image setup, and
image capture options.

§ File opening - The file open and save options are for the most part identical to the
standard Windows file open and save options.  There are also several features that are
unique to the SPOT software.  Refer to the Opening and Saving Files section in this
Chapter for more details on opening and saving image files in SPOT.

§ Image setup - Defining or selecting an image setup is the crucial first step in the
picture taking process. All of the image setup options can be accessed via the Setup
menu.  Refer to Chapter 3, Preparing to Take a Picture, for more details on defining
and utilizing image setups.

§ Image capture - Image capture (picture taking) options are accessed via the Camera
menu.  For more details on capturing an image, refer to Chapter 4, Taking a Picture.
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The Toolbar

When you first open the SPOT program, the Toolbar appears on the left hand side of the
screen.  The Toolbar buttons are shortcuts to frequently used menu items.  Like the
menus, the Toolbar varies according to the whether an image is open, and what you are
doing.

Dragging the cursor over the Toolbar displays information about each button.

§ The name of the button displays the name of the associated menu option.

§ The function that the button performs displays on the left hand side of the view status
bar.

The Toolbar buttons can be classified into three categories:

§ File save and print options

§ Image capture and view options

§ Image annotation options

As a default, the Toolbar displays the file save/print options and the image capture/view
options.

! Note: To use the image annotation options, you must select the Annotate option
from the Edit menu.  The annotation buttons then replace the image capture and
view buttons.

Each set of options is discussed below.

File Save and Print Options

The file, save, and print options appear as the bottom part of the toolbar.  The following
table illustrates the file save and print Toolbar buttons:

Save

Save As

Save to Database

Reload

Print

Search

! Note:  Refer to Chapter 8, Printing Options, for more details on printing from the
SPOT program.
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Image Capture and View Options

The image capture and view options appear as the top half of the toolbar.  These options
are accessible after you have captured an image and you want to edit and/or recapture the
image.  The following table illustrates the image capture and view buttons:

Get Image (exposure from setup)

Get Image (last used exposure)

Focus

Frame

Compute Exposure

Compute White Balance Values

Zoom

Show Pan Window

! Note:  Refer to Chapter 4, Taking a Picture, and Chapter 5, Viewing, Editing, and
Annotating Images for more details on these options.

Image Annotation Options

In addition to editing an image for resolution, clarity, and color, the SPOT software
allows you to annotate images by adding explanatory text and illustrations.

! Note: Image annotation is described in detail in Chapter 5, Viewing, Editing, and
Annotating Images..

When you select the Annotate option from the Edit menu, the annotation buttons replace
the image capture and view buttons at the top of the Toolbar.  The following table
illustrates the image annotation toolbar buttons:

Select

Freehand

Straight Line

Arrow

Rectangle

Ellipse

Polygon

Stamp

Text



Ch. 2 - Navigating the SPOT Software The Viewing and Editing Window

User's Guide to the SPOT Cooled Color Digital  Camera, 6/9/98 13

The View Status Bar

The view status bar, which appears at the bottom of your screen, displays information
about the image that is on screen.  The following is an illustration of the view status bar,
as it appears for an open image:

From left to right, the view status bar displays the following information:

§ Image size - The size of the image in square pixels (i.e., 766, 512).  The standard size
for an image is represented by the size of the CCD chip, which for the SPOT camera
is 1315 pixels x 1035 pixels.  Thus, for unmodified images that are captured with the
SPOT camera, this measurement will read (1315, 1035).

§ Pixel bit depth (bits per pixel) - The pixel bit depth at which the image was captured
appears next to the size values.  This value reflects the pixel bit depth for the image
setup that you used to capture the image.  There are four options:

− 8 bpp (monochrome)

− 12 bpp (monochrome)

− 24 bpp (RGB color)

− 36 bpp (RGB color)

! Note: For a detailed discussion of pixel bit depth, refer to Chapter 3, Preparing to
Take a Picture.

§ X Y pixel coordinates - As you move your cursor over an image, the view status bar
displays the x y coordinates in pixels.  Thus, for an image that uses the entire CCD
chip, the values for the upper left corner of the image would be (0,0), while the lower
right values would read (1315, 1035).

§ Brightness values - As you move your cursor over an image, the view status bar
indicates the brightness values for the pixel coordinates.  The values depend on the
pixel bit depth for the image.  For example, if the image was captured using a 24 bpp
image setup, the view status bar displays separate red, green, and blue brightness
values for each part of the image [i.e., RGB: (162, 134, 127)].  If the same image
were captured with (or changed to) a different pixel bit depth (i.e., 8 bpp), only one
brightness value is displayed [i.e., (176)].

§ Size Settings - In the illustration above, the view status bar displays Normal.  This
indicates two things:

− The open image is being viewed in a non-zoomed mode.

− The Fit to Window option has not been selected.  If you select the Fit to Window
option (see the Preliminary Settings section of this chapter), the words Fit to
Window appear in this section.
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When you select the zoom mode, either via the View menu or the Toolbar button, the
status changes to Mag:x1, indicating the fact that you are in zoom mode, as well as
the magnification.  When you zoom out the status bar displays the magnification in
fractional values (i.e., Mag:x1/4).

§ Modified Status - The section to the right of the magnification setting remains blank
until you modify an image.  Once an image has been modified from the original
status, the word Modified appears here.

§ Image Setup - The far right end of the view status bar displays the currently active
Image Setup (i.e., Factory Defaults).  This is the image setup that the program uses to
capture images.  From this part of the view status bar, you can:

− Change the currently active image setup.

− Modify an existing image setup.

− Add a new image setup to the list.

! Note:  Refer to Chapter 3, Preparing to Take a Picture, for more information on
image setups..

Opening and Saving Files

All of the file open and save options in the SPOT program can be accessed from the File
menu and the Toolbar.  The file open and save options in the SPOT software can be
classified into two categories:

§ Standard Windows options.

§ SPOT specific options.

These options are discussed in the sections below.

Standard Windows Options

The majority of File menu commands in the SPOT program work in the same way as any
standard Windows 95 program would.  The following section lists these commands.

! Note: The standard windows functions are not described in detail in this chapter.
For more detail on these functions, refer either to the Windows  on - line help or to
the context sensitive help in the window.  To use the context sensitive help, left click
on the question mark icon at the top of the window.  A question mark now appears
next to the cursor.  Position the question mark/cursor over the area of the window
that you have a question on, and left click.  A pop-up window explains the item.
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Open File

Use the Open File command to open image files of a specified format (i.e., JPEG, GIF,
BMP, etc..).

Save

Use the Save option to save a previously unsaved image to new file, or to update the
changes to an existing file.

Save As

Use the Save As option to save an image to a new file and/or file location.

Close

Use the Close option to close an image.  The program prompts you to specify a location
to save the file.

Delete

Use the Delete option to delete an open image.  The program prompts you to verify the
deletion.

Print/Print Setup

Refer to Chapter 8, Printing Options for information on standard Windows and SPOT
custom printing features.

Exit

Exit the SPOT program.

SPOT Specific Options

The following options are specific to the SPOT program.

Open Database Image

Use the Open Database Image option to open an image from a SPOT database.  The
SPOT database from which you want to open the image must be open.
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To open a database image, follow these steps:

1. From the File menu, select the Open Database Image option.  The following window
appears:

2. Enter the Image ID.  To find the system assigned Image ID, select the Search option
from the Database menu; the Image ID for each image displays with the search
results.  If the search results are displayed in tabular form, the Image ID appears in its
own column.  If the search results are displayed as thumbnails, right click on the
thumbnail to display associated information, including the Image ID.

Show File Thumbnails

Use the Show File Thumbnails option to display thumbnail previews of specified files.
You can open the image from the preview screen.

To use the Show File Thumbnails options, follow these steps:

1. From the File menu, select the Show File Thumbnails option.  The following window
appears:

2. Specify the file type.

3. Specify a file location.  If you specify the file location without selecting individual
files, the program displays thumbnails for all files of the specified type in that
location.
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4. Click on Open.  The Thumbnails preview window appears, as shown here:

Save to Database

Use the Save to Database option to save an image to a SPOT database.  To save an image
to a SPOT database, follow these steps:

1. Ensure that the database that you want to save the image to is open.

2. From the File menu, select the Save to Database option, or click on the Save to
Database Toolbar button:

3. The Save Image to Database window appears.  Enter the appropriate information for
the database.

! Note:  For details on saving images to a SPOT database, refer to Chapter 7, Using
SPOT Databases..

Save All

Use the Save All option to save all open image files.  The program prompts you for the
name and file location of each image.



Ch. 2 - Navigating the SPOT Software Preliminary Setting

User's Guide to the SPOT Cooled Color Digital  Camera, 6/9/98 18

Preliminary Settings

There are two program settings that should be checked/defined prior to capturing images.

§ Preferences
§ Initialize

Preferences

The SPOT program allows you to set three basic operating preferences:

§ Toolbar position (on-screen)
§ JPEG image quality
§ Automatic fit to window sizing

To set the operating preferences, follow these steps:

1. From the Setup menu, select the Preferences option.  The following window appears:

2. Select the screen position for the Toolbar Placement.  The default is Left Side.

3. Enter an integer between 1 and 100 to set the JPEG quality for images.  JPEG quality
refers to the level of compression for JPEG images.  A value of one is the most
compressed (and lowest image quality), while a value of 100 is the least compressed
(and highest image quality).  The default setting is 100.

4. Determine whether images should open in Fit to Window mode.  This box is checked
as a default.  If this option is selected, the program automatically sizes images to fit
the available screen space when you open or capture an image.  Thus, you can im-
mediately see the entire image without having to zoom out.  This is especially useful
with smaller monitors.

Initialize

If you turned on the SPOT power supply after you opened the program, you need to
initialize the camera in order to activate all of the capture and editing options.  To do so,
select the Initialize option from the Camera menu.
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Introduction: What is an Image Setup?
In the SPOT software, an image setup serves two purposes:

§ It defines the way a picture will be taken.

§ It defines the way a picture will be modified after it is taken.

Individual image setups can be tailored to optimize the picture taking process for
different types of images or microscopy techniques.  These image setups can be created,
saved, and recalled as needed.

Each image setup is defined according to settings that are entered in four general
categories:

§ Pixel Bit Depth

§ Image Depth (resolution)

§ Exposure

§ Image Area

§ Auto Corrections (post-exposure adjustments)

! Note: Each of these items will be discussed in more detail in the sections that
follow.

So, if your work involves samples where the specimen is typically the brightest part of an
image (i.e., fluorescence), you can set the Image Type exposure option to Dark Field.
This allows the camera to properly expose such a picture.  For your convenience, the
SPOT software offers four (in addition to the Factory Defaults) pre-defined Image
Setups:
§ Brightfield

§ Fluorescence

§ Glints #1

§ Glints #2

Because the options that you select directly impact the quality of the final image, you
should choose the image setup carefully.
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Accessing the Image Setup Screen

To define a new Image Setup or to edit an existing Setup, follow these steps:

1. From the Setup menu on the menu bar, select the Image Setups option.  The Image
Setups window appears:

Select one of the following options:

− Add - To create a new image setup, click on the Add button.  The Image Setup
dialog box appears.

− Modify - To edit an existing image setup, select a setup from the list, and click on
the Modify button. The Image Setup window appears.

Note:  The Factory Defaults setup cannot be modified.

− Delete - To delete an image setup, select a setup from the list and click on the
Delete button.

− Current – To make a setup the active setup, select the setup from the list and
click on the Current button.

− Close - To exit the dialog box, click on the Close button.
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2. If you select the Add option, the Image Setup screen appears, as illustrated below:

! Note: If you click on the Modify button, the Image Setup screen displays the name
of the selected Setup and its associated settings.

Shortcuts: The SPOT program provides quick access to the Image Setup screen via a
selection tab that appears in the bottom right hand corner of your screen.  The tab displays
the name of the current (active) Image Setup.

− To change the current (active) Image Setup, left click on the tab and select the new
Image Setup.

− To go directly to a new Image Setup or to modify an existing Image Setup, right
click on the tab, and select either the Add or the Modify option.

− To access the current Image Setup directly, press [F12].
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Image Setup Options

The Image Setup screen is broken down into five parts:

§ Setup Name
§ Pixel Bit Depth
§ Exposure
§ Image Area
§ Auto-Corrections

Each part and the associated options is discussed in the following sections.

Setup Name

Use this box to enter the name of a new Image Setup, or to modify the name of an
existing Setup.  If you modify the name of an existing setup, the program asks (when you
click on OK to save the setup) if you want to save this as a new setup or overwrite the
original setup.

Pixel Bit Depth

Pixel Bit Depth is the number of bits per pixel (bpp) that the camera uses to create an
image. The program provides four options:

§ 8 bpp – monochrome
§ 12 bpp - monochrome
§ 24 bpp- color
§ 36 bpp - color

The 24 bpp RGB color setting is the most common selection because it is an industry
standard color format that is used by Windows and most printers.  In addition, most
monitors cannot display more than 24 bpp.

To select a Pixel Bit Depth, click on the Bits per Pixel scroll bar, and select one of the
four options.  Because the Image Depth that you select determines whether your image
will be monochrome or color, it also determines the available exposure options.  The
Exposure section of the Image Setup window changes accordingly.  The following table
lists the available image depth options and describes some of the potential uses,
advantages, and disadvantages associated with each setting:
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Pixel Bit Depth Settings Characteristics

8 bpp (monochrome) The 8 bit setting is often used in cases where 256 gray levels are
adequate.  The lower number of bits per pixel results in smaller,
more manageable image file sizes.

A typical 8 bpp image is 1.29 Mb

12 bpp (monochrome) The greater number of bits per pixel in the 12 bit setting provides
users with 4096 gray levels.  This provides a more accurate
means of measuring brightness in a monochrome image, and
helps to reduce banding problems that often appear when an
image is modified.  One of the disadvantages of using the 12 bit
setting is that all pictures will be taken at a gain of one.  The
inability to use higher levels of gain means that exposure times
for dim images will be longer.  And, file sizes are larger.

A typical 12 bpp image is 1.94 Mb.

24 bpp (RGB color) The 24 bit setting provides 8 bits per color, per pixel (i.e., 8 x 3 =
24).  As noted, the 24 bit setting is the most common choice for
most users because it is an industry standard in terms of printing,
the Windows operating system, and monitor display. This setting
meets the needs of most users.

A typical 24 bpp image is 3.88 Mb.

36 bpp (RGB color) The 36 bit setting provides 12 bits per color, per pixel (i.e., 12 x 3
= 36).  The 36 bit option is often used in cases where images are
heavily modified.  Like the 12 bit option, the 36 bit setting
provides users with 4096 brightness levels per color and thereby
reduces banding problems when images are stretched.  As with
the 12 bit setting, all pictures are taken at a gain of one.

A typical 36 bpp image is 5.83 Mb.

Exposure

The Exposure options on the Image Setup window tell the camera what settings to use
when taking a picture.  Carefully considered definition of these settings helps to ensure
that your images come out in the way that you want them to.

! Note:  As noted earlier, the available exposure options vary according to the image
depth that you select.
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Auto-Exposure vs. User-Defined Exposure

With the SPOT camera, you can either allow the camera to calculate exposure time (Auto
- Exposure), or you can use one of three methods to calculate the exposure on your own
(User - Defined Exposure).
§ When you select the Auto – Exposure option, the camera samples light levels (as the

initial part of the image capture) and uses the values to calculate the final exposure
time.

§ When you select the User – Defined Exposure option, you have three options:

− You can type in values for the red, green, and blue exposure times.

− You can use the Compute Exposure option to calculate and insert the exposure
times (and gain) for you.

− You can use the Recall Previous Exposure option to recall and insert the exposure
times and gain used for the last picture.

The following table is an illustrated comparison of the available exposure options for
automated and user defined exposures at all four image depth settings.

Auto-Exposure Options User-Defined Exposure Options
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(cont.)

Auto-Exposure Options User-Defined Exposure Options

! Note: Each of the above screen captures shows only the Pixel Bit Depth and Ex-
posure sections of the Image Setup screen.

The sections that follow detail all of the Exposure options.  If an option is available only
with certain Image Depth settings, or if an option is associated only with automated
exposure or user-defined exposure, this is indicated parenthetically in the heading.

Filter Color (8 and 12 bit mono)

The Filter Color option allows you to specify the color of the filter that will be used when
taking a monochrome picture.

SPOT2 SPOT2 users can slide the camera’s color filter out of the light path to produce an
entirely unfiltered image.  With the filter out of the light path, it does not matter which
color is selected.

In order to ensure a high image quality, SPOT users should select the color that is closest
to the color of the specimen.  Selection of the wrong filter color blocks the desired color.
For example, if you are looking at only one color, as in the case of a single stained
fluorescence, selecting the color filter that most closely matches the color of the stain will
shorten the time it takes to acquire the image.

To select a the filter color for capturing a monochrome image, follow these steps:

1. Ensure that the Pixel Bit Depth is set to either 8 (mono) or 12 (mono).

2. Click on either the Auto-Exposure or the User-Defined Exposure option.

3. Select one of the following options:

− Red
− Green
− Blue
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Use:  Red  Green  Blue (24 and 36 bit RGB)

The Use Red Green Blue option allows you to specify the colors that will be exposed.
For most situations, you should select all three colors.  However, in situations where you
know that your specimen lacks one or two of the colors, you can avoid the additional
exposure and download time by “turning off” (deselecting) the missing colors.  For
example, if you have a pumpkin colored fluorescence sample with no blue in it, you can
deselect the blue value.  The camera only exposes the red and green values.

! Note:  When you add a new 24 bpp or 36 bpp image setup, all three colors are
selected as the default.

To set the color filters for capturing a color (RGB) image, follow these steps:

1. Ensure that the Pixel Bit Depth is set to either 24 (color) or 36 (color).

2. Click on either the Auto-Exposure or the User-Defined Exposure option.

3. Deselect one or two of the color option boxes, or leave all three checked.

− Red
− Green
− Blue

! Note:  In order to save the image setup, at least one color must be selected.

SPOT2 If capturing an unfiltered image, it does not matter which color you select.

Color Order (24 and 36 bit RGB)

In addition to allowing you to specify specific exposure colors, the SPOT camera allows
you to specify the order in which the colors are exposed.  This feature is particularly
useful for triple stained fluorescence samples, where one color dye might fade before the
others.  For example, if a green dye fades first, you can set green to be the first exposure,
thereby catching the green parts of the sample before they fade.  To set the Color Order
for an image capture, follow these steps:

1. Select the color or colors that you want to expose for the picture.

2. Click on the Color Order scroll bar.

3. Select the Color Order that you want to use.

! Note: The default Color Order setting for a full color image is RGB.
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Binning

Binning is a pre-exposure option that tells the camera to combine adjacent pixels on the
CCD chip.  The camera treats each set of combined pixels as one large pixel, and more
photons hit this large pixel than each of original small pixels.  The large pixels
accumulate electrons faster and are therefore more sensitive to light.  Binning has three
effects on image processing:

§ Light sensitivity is increased.

§ Download time is decreased.

§ Resolution is decreased.

Binning is particularly helpful when you want to drastically reduce exposure and
download times for dim images and you don’t mind a decreased resolution.

The SPOT camera offers four binning options, each of which is illustrated in the table
below:

Binning Options Combined Pixels on the CCD Chip

None

2 x 2
(4 pixels = 1)

3 x 3
(9 pixels = 1)

4 x4
(16 pixels =1)

The default binning option is set to None.  To select a new binning option, click on the
setting that you want to use.
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Image Type (Auto-Exposure)

When using the Auto-Exposure option, the SPOT camera provides two Image Type
settings to choose from, Brightfield and Darkfield:

§ Brightfield – Use the Brightfield setting for transmitted light brightfield images.
The Brightfield setting instructs the camera to over-expose (burn out) the brightest
parts of the picture (i.e., the background).  The additional exposure results in the loss
of detail to the background, the least important part of the image, and enhanced
brightness to the specimen, the most important part of the image.

! Note:  Brightfield is the default setting for the SPOT camera.

§ Darkfield – Use the Darkfield setting for images where the specimen is the brightest
part of the image.  The Darkfield setting instructs the camera to correctly expose the
brightest parts of the picture (i.e., the specimen). The Darkfield setting is ideal for
capturing fluorescent images.

The following two pictures illustrate a typical bright field image and a typical dark field
image:

Figure 1: Typical Bright Field Image Figure 2: Typical Dark Field Image

Auto-Gain Limit (Auto-Exposure, 8 bit  and 24 bit)

As described in Chapter 2, “Electronic Imaging Theory and the SPOT Camera,”
increasing gain enables the SPOT camera to capture dim images without using lengthy
exposure times.  The Auto-Gain Limit feature allows you to set an upper limit on the gain
options that the camera has to choose from during the Auto-Exposure process.

! Note:  The User-Defined Exposure option allows you to precisely set the gain for
an image capture.
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For example, an Auto-Gain Limit of 16 allows the camera to choose from the full range
of gain options.  However, if you have found that gain settings of 8 or 16 are too noisy
for the type of work that you do, you can restrict the camera from selecting these options
by setting the Auto-Gain Limit to four.  When the Auto-Gain Limit option is set to four,
the camera is limited to one of the lower three of the five gain options: 1, 2, or 4.  The
following table illustrates the five levels of gain that correspond to the SPOT camera’s 24
bit RGB capabilities, as well as the relationship between gain, the fraction of full well
that the brightest pixel is filled to, and exposure time:

Gain Fraction of Full Well Exposure Time (sample)

1 1 80 seconds

2 1/2 40 seconds

4 1/4 20 seconds

8 1/8 10 seconds

16 1/16 5 seconds

The advantage of allowing the camera to use a higher gain level for dim images is that
the exposure time is reduced significantly.  For each doubling of gain number, exposure
time is halved.  Thus, an image with an exposure time of 5 minutes at full scale (a gain of
1) would take only 1.25 minutes at a gain of 4.  Unfortunately, background noise
increases proportionally to the gain.  Thus, the shortened exposure time would result in
an image with four times the amount of background noise.  The following table illustrates
the relationship between gain, exposure time, and background noise:

Auto-Gain Limit Possible Auto - Gain
Settings

Exposure Time
(dim images)

Background Noise
(dim images)

1 1 Longest Lowest

2 1, 2 é ê

4 1, 2, 4 é ê

8 1, 2, 4, 8 é ê

16 1, 2, 4, 8, 16 Shortest Highest

To set the Auto-Gain Limit, follow these steps:

1. Ensure that the camera is set to use the Auto-Exposure option.

2. Click on the Auto-Gain Limit select list, and select the number that you want to limit
the gain to.
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! Note:  For more information on the concept of gain, refer to Chapter 1, Electronic
Imaging Theory and the SPOT Camera.

Adjustment Factor (Auto-Exposure)

Use the Adjustment Factor option to modify the automated exposure settings determined
by the SPOT camera.  The Adjustment Factor defaults to a setting of 1 (i.e., 1x the
exposure times determined by the Auto-Exposure setting.)  The Adjustment Factor is
used to deliberately over-expose or under-expose an image.  The Adjustment Factor
option can be used if:

§ An image that you captured (using the default Auto-Exposure settings) comes out too
bright or too dark.  In this case, you can re-capture the image using a different
Adjustment Factor to compensate for the excess brightness or darkness.

§ You use the SPOT camera to take pictures of printed circuit boards or other metallic
objects.  In this type of situation, the Adjustment Factor allows you to over-expose
the image in order to burn out the glints that appear when capturing images of
metallic objects.  Over-exposing the glints is necessary to correctly expose the non-
glinted areas.

To set the adjustment factor, click on the scroll bar, and enter a number between .25 and
32.

! Note:  The software includes two default Image Setups that you can use to handle
images with glints: Glints #1 and Glints #2.

White Balance (Auto-Exposure, 24 and 36 bit RGB)

White balance is the ratio of red, green, and blue exposure times necessary to achieve the
proper color rendition for an image.  Many factors impact the coloration of an image
capture, including lamp voltage, the coloration of the glass used in the slide, and the
coloration of the glass used in the lenses of the microscope’s objectives.  In order to
minimize the impact of these factors, the Compute White Balance feature samples the
color of the light from your light source after it has passed through your slide and the
objective’s lenses.  and calculates the exposure values needed to produce images where
the white areas are white and the color areas are true.

You should perform a new white balance calculation in the following cases:

§ When you start a new image capture session.

§ When you change the lamp voltage.

§ When you switch to a different objective on the microscope.
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When you open an image setup, the Image Setup screen displays the default white
balance values for that Setup, which are the values that were last saved to the Image
Setup.  If you capture an image without computing a new white balance, SPOT uses the
default values.

To compute new white balance values for an image setup, follow these steps:

1. Set the illumination and the objective that you will use for the image capture.

2. Show the camera a sample of white light.  This step varies according to microscopy
technique and sample type:

− For transmitted light brightfield microscopy, position the slide so that the
specimen is not in the field of view, but light is going through the slide near the
specimen.

− For brightfield metallurgical microscopy, replace your sample with a mirror.

− For low magnification work using an EPI-illuminator (shining a light on the top
of your specimen from off to one side), replace your sample with a white sheet of
paper.

! Note:  EPI illumination is usually performed with a stereo microscope or a macro
lens.

3. From the Camera menu, select the Compute White Balance Values option, or use the
toolbar and click on the Compute White Balance Values button, illustrated here:

4. The Compute White Balance window appears, as follows:

5. Click on the Begin button to start the calculation.  The Compute White Balance
window displays the status message Computing white balance values.  You should
hear a series of clicks as the camera samples the light.
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6. When the camera finishes calculating the white balance values, the following window
appears:

7. The computed white balance values appear, along with the Save to Setup option.  The
camera automatically saves the computed values to the current active setup (i.e., the
image setup that appears in the scroll bar at the bottom right corner of the screen).

! Note:  Due to the inherently poor blue light sensitivity of CCD chips and the
energy distribution of halogen bulbs, the blue value is often much higher than the
red and green values.

8. To change the setup that the new white balance values are saved to, click on Save to
Setup scroll bar, and select a setup from the list.

9. Click on OK.

10. The program returns to the main screen.

11. To edit the white balance values that you saved, open the image setup (i.e.,
Brightfield from the previous example).  The values should appear in the Red, Green,
and Blue selection bars. Edit the values as needed.

Exposure Time(s) (User Defined Exposure)

There are two options for entering user-defined exposure times.  With the SPOT camera,
you can:

§ Manually enter the value(s).

§ Allow the camera to calculate the value(s).

§ Recall the exposure times and the gain used for the previous image capture.

Each of these options is discussed below.
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When you select the User-Defined option on the Image Setup window (either to create a
new Image Setup or to modify an existing setup, default values appear for the Exposure
Time(s).

To manually enter a new exposure value(s) follow these steps:

1. Ensure that the User-Defined Exposure box is selected.

2. Either use the selection arrows or type in a value in seconds for the exposure time.

− The minimum exposure time is 80 milliseconds (.080 seconds) per color.

− The maximum exposure time is 17 minutes (1020 seconds) per color.

3. Click on the OK button to save the settings.

To have the camera calculate the exposure time, follow these steps:

1. Close the Image Setup window.

2. Close the Image Setups dialog box.

3. From the Camera menu, select the Compute Exposure option.

Shortcuts:  To compute exposure values, you can also use one of the following two
methods:

− Press [F 10].

− Click on the Compute Exposure values button on the toolbar:

4. The Compute Exposure screen appears as shown below:
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5. The Exposure Settings for the current image setup appear for your review. If, upon
consideration, you decide to change the settings, they can be changed from this
window.  Any changes that you make will be saved to the current setup.  In addition,
if you want to save image setup changes to a setup other than the current one, you can
specify the image setup from this screen.

! Note:  For information on entering Image Type, Auto-Gain Limit, Adjustment
Factor, and White Balance, refer back to the appropriate section in this chapter.  

6. Click on the Begin button.  The Status message changes to Computing exposure…
You should hear a series of clicks as the camera samples the light.

7. When the camera finishes, the Exposure window displays the calculated exposure
times and gains, as illustrated here:

8. Select an image setup from the Save to Setup scroll bar.  The current image setup
should appear as the default.

9. Click on OK.  When you open the Image Setup window, the new exposure value(s)
should display.

When you save the calculated exposure values to an image setup, it automatically
changes the setup from Auto – Exposure to User Defined.

To recall the exposure times and gain from the previously captured image, follow these
steps:

1. After you have captured the initial image, select the Recall Previous Exposure option
from the Camera menu.  The Exposure window displays the exposure times and gain
used for the previously captured image, as shown on the next page:
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2. Select the setup that you want to save the settings to, and click on OK.  The settings
are saved to the image setup that you specified.

When you save the previously used exposure values to an image setup, it auto-
matically changes the setup from Auto – Exposure to User Defined.

Gain (User-Defined Exposure, 8 bit and 24 bit)

When you define your own Exposure, you can enter the precise gain that the camera will
use for an image capture.  Unlike the Auto-Gain limit feature, which sets a limit within
which the camera can work, the Gain option defines a precise gain setting.  As with
exposure, you can enter a specific gain in three ways:

§ You can manually enter the gain by selecting one of the five gain options from the
selection list.

§ You can let the camera compute the best gain (and exposure times) by using the
Compute Exposure feature.

! Note:  Refer to the previous section for details on using the Compute Exposure
feature.  The gain displayed in the Exposure window is automatically saved to the
image setup that you specify.

§ You can use the Recall Previous Exposure feature to recall the gain from the previous
image capture.

! Note:  Refer to the previous section for details on using the Recall Previous
Exposure feature.

To manually enter a gain, follow these steps:

1. Ensure that the User-Defined Exposure option is checked.

2. Ensure that you are using either the 8 bit or 24 bit image depth setting.

3. Select one of the five gain options from the list.
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To use the gain that the camera selects, follow the steps (in the previous section) listed
for computing exposure times.  The Exposure window, in addition to the optimal
exposure times, displays an optimal gain.  This gain is automatically added to the image
setup that you specify in the Save to Setup box.

! Note:  The Compute Exposure window displays the Auto-Gain limit defined for the
current image setup.  This limits the gain options that the camera can choose
from.  If you do not want to use the Auto-Gain Limit shown, it can be changed
from the Compute Exposure window.

Image Area

The third major section of the Image Setup window is Image Area.  The SPOT software
allows you to use any rectangular portion of the CCD chip for image capture.  Using a
portion of the chip is helpful in cases where you want to:

§ Keep file sizes small.

§ Shorten download times.

§ Avoid areas of the image with optical problems (i.e., vignetting).

There are three image area options:

§ Full Chip – Use the Full Chip option to capture the entire area of the CCD chip.

§ Center – Use the Center option to capture a rectangular part of the CCD chip’s area
that has the same ratio of height to width as the full chip, and is centered on the center
of the full chip.  The percentage that you enter is the percentage of full chip width that
the new area’s width will be.

To define an image setup to capture a centered proportion of an image, follow these
steps:

a) On the Image Setup window, check the Center option.

b) Enter the percentage of the image that you want to capture.  The minimum
percentage that can be entered is 10 and the maximum is 100.

c) Click on OK to save the image setup.

§ Region – Use the Region option to capture a specific part of the CCD chip (i.e., the
image).

If you have pre-determined the exact pixel values of the area that you want to define
(an infrequent scenario and the more difficult method), follow these steps:

a) On the Image Setup window, check the Region option.

b) Enter the pixel values for the Left and Right columns and the Top and Bottom
rows that form the boundaries of the region that you want to define.

c) Click on OK.  The camera captures the region that you selected.
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If you do not know the exact pixel values of the area that you want to capture (the
most common scenario and the easier method), do the following:

a) Click on the Full Chip option.

b) Capture the full image [i.e., select the Get Image (exposure from setup) option
from the Camera menu].  The image capture appears on the screen.

c) Position the cursor at the upper left edge of the image region that you want to
define.

d) Click on the left mouse button and use the mouse to drag the cursor across the
screen.  A dotted border appears around the area of the image that you selected.

e) From the Camera menu, select the Set Image Region option.  The Image Region
window displays the pixel values for the region that you selected, as illustrated
below:

f) Click on OK to save the region values to the current image setup, or select a
different image setup.  The region values are now saved to the Image Setup.

Auto Corrections

The fourth and final aspect of defining an image setup is to determine the post-exposure
adjustments (corrections) that you want the SPOT camera/software to make.  The
available corrections/adjustments include the following:

§ Chip Defect Correction
§ Noise Filter
§ Image Size Double
§ Gamma Adjust
§ Horizontal Flip
§ Vertical Flip
§ Background Subtract
§ Flat-Field Correct

The following sections describe the available options.
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Chip Defect Correction

All CCD chips have inherent defects.  When you capture an image, the SPOT program
automatically compensates for these defects so that they do not appear on your images.
The Chip Defect Correction option allows you to turn off this automatic correction.  This
can be useful in cases when you are performing quantitative measurements of pixel
brightness values and need to see precisely where chip defects are.

The Chip Defect Correction box is, as a default, checked when you define a new image
setup.  To turn off the program's automatic chip correction, deselect the Chip Defect
Correction box.

Noise Filter

The Noise Filter box eliminates pixels that appear out of place due to electrical or thermal
noise.  If activated, the noise filter checks each pixel on the CCD chip three times, once
each for the red, green, and blue values.  If the brightness value for a pixel differs from
any one of the eight surrounding pixels by more than plus or minus the entered
percentage, it is replaced with the average value of the surrounding eight pixels.

To activate the Noise Filter option, check the Noise Filter box, and enter a value between
10 and 100.  The default value is 50 %.  The program automatically runs the noise filter
each time an image is captured with that image setup.

Image Size Double

When you select the Image Size Double feature, the camera interpolates between pixels
in order to create an image that is twice as large.  The program reads the red, green, and
blue brightness values for the original (1315 x 1035 pixel) image and interpolates those
values to create a new image that has double the number of columns and rows (i.e., 2630
x 2070 pixels).  The red, green, and blue values for the additional pixels are calculated
based on the RGB values of the original pixels.

The Image Size Double feature helps to reduce the pixellation of fine detail that often
results when you use lower magnification objectives.  When used with low magnification
images, the additional pixels created via the Image Size Double feature help to smooth
out details, which results in the appearance of a higher resolution.

To activate the image size double feature, check the Image Size Double box.
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Gamma Adjust

The Gamma Adjust option allows you to smoothly lighten darker areas of an image
without burning out bright areas or lightening black areas.

The Gamma Adjust option is especially useful for capturing/editing images with a wide
dynamic range, meaning the range of brightness values recorded by the CCD chip.  Some
examples of wide dynamic range images include:

§ Fluorescence specimens

§ Macroscopic objects with glints, such as printed circuitry

When the bright areas of these types of images are correctly exposed, the darker areas are
sometimes so dark that they are in effect invisible.  Using the Gamma Adjust option can
remedy this problem.  The screen captures on the following page illustrate the effect of a
gamma adjust on a fluorescent image.  The image on the left is the original image, prior
to the gamma adjust.  The image on the right has been gamma adjusted to a value of 1.75
(a value of 1 indicates that the image has not been gamma adjusted).  In this instance, the
gamma adjustment results in a better display of detail by lightening the darker areas
without burning out bright areas or lightening black areas:

Figure 3: Fluorescence image, no gamma adjustment Figure 4: Fluorescence image, gamma adjusted to 1.75
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Gamma adjustment corrects an image by creating a new version of the original.  To
create the new image, the Adjust Gamma (RGB) function reassigns the RGB values of
each pixel in the image according to the curve in the following graph:
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The above graph demonstrates some of the basic principles of gamma adjustment:

§ Black (pixel value = 0) remains black at all gamma values.

§ White (pixel value = full scale) remains white at all gamma values.

§ Gamma values greater than one lift the darker areas of the original image into the
brighter areas of the new image.

§ A gamma curve is smooth: there are no unexpected jumps or cutoffs.  This means that
when viewing a gamma adjusted image, you will be able to see the details (intensity
differences) in both the black and white areas of the image.

To use the Gamma Adjust option, follow these steps:

1. Check the Gamma Adjust box on the Image Setup window.

2. Enter a gamma value between .1 and 4.0.  Although there is no formula for
determining a gamma value, gamma values are typically between 1.3 and 1.7

! Note:  Although the gamma adjust option is typically used to lighten the mid-tones
of an image, entering a value between .1 and 1 will darken the mid-tones.
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3. Select either the Luminance or the RGB option by checking the appropriate box.  The
Luminance and RGB options correspond to two methods of applying gamma to an
image, as described in the table on the following page:

Luminance RGB

If you select the Luminance option, the
gamma adjustment process works as
follows:

1. The program translates the RGB pixel
values to HSL (hue, saturation, and
luminance) values.

2. Gamma is applied to the luminance.

3. The HSL values are translated back to
the RGB pixels.

If you select the RGB option, the gamma
adjustment process works as follows:

Gamma is applied separately to the red,
green, and blue pixel values.

Usage/Recommendations

§ The Luminance option is ideal for
brightfield and macro images with subtle
hues because it preserves the hue of the
darker areas of images as they are
lightened.

§ The Luminance option is not
recommended for images that have only
simple red, green, or blue colors.  The
brightest areas might turn out white or
pastel.

§ The RGB option is ideal for images with
simple red, green, and blue primary
colors.  It is not recommended for
images with many subtle hues.  The hue
of subtly colored dark areas tends to
change as they are lightened, while
bright, saturated colors remain saturated.

§ The RGB option is recommended for
most fluorescence images.

4. Click on OK to save the Gamma Adjust settings to the Image Setup.  When you
capture an image using the setup, the program will automatically gamma adjust the
image according to the settings that you defined.

! Note:  From the Image Setup window, you can specify whether or not to auto-
matically apply a gamma adjustment to an image after it is taken.  This works well
if you know in advance which gamma value works well for a specific class of
images.  If you are not certain of the best gamma value, you can acquire non-
gamma adjusted images, and then use the RGB or HSL gamma adjust options on
the Edit menu.  In this way, you can experiment with the gamma adjust options
until you find an optimal value.  For more information, refer to Chapter 5,
Viewing, Editing, and Annotating Images.
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Horizontal Flip

To flip an image display from left to right, check the Horizontal Flip box.

! Note:  The Horizontal Flip option is also available from the Edit menu.

Vertical Flip

To flip an image from top to bottom, check the Vertical Flip box.

! Note:  The Vertical Flip option is also available from the Edit menu.

Background Subtract

The Background Subtract option allows you to rid your images of the background glow
that is sometimes seen in fluorescence images.  Sometimes, you will notice this glow
while looking at the specimen under the microscope; other times, you will only notice it
after you have already captured an image.

The Background Subtract option works by taking two pictures of a slide, using the same
exposure and gain settings: a foreground image that contains the specimen and the
background glow and a background image that contains only the background glow.
When you select the Background Subtract option, the program subtracts the background
image from the image of the specimen, thereby removing the background glow.  The
following pictures illustrate a fluorescent image before and after application of
background subtraction:

Figure 5:  Fluorescent sample prior to background
subtraction

Figure 6: Fluorescent sample after background
subtraction
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To use the Background Subtract option, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.

2. From the Camera menu, select the Get Background Image option.  The following
window appears.

3. Click on the Begin button.  The following window appears:

4. If the specimen is not in the objective’s field of view, move it into place, and click on
OK.  The Get Background Image window appears:

5. You should hear a series of clicks as the camera computes the exposure time.  The
following window appears:
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6. Move the slide so that only the background portion of the specimen is in the field of
view, and click on OK.  The Get Background Image window appears, as shown here:

7. When the program finishes getting the background image (i.e., the image that will be
subtracted from the final image of the specimen), the Background Image File window
prompts you to name the background image:

8. Enter a name in the File Name box.  Because background image files are different for
each objective, you might want to name the background file according to the
objective's magnification (i.e., 10x).

9. Choose the file location that you will save the background image to.  The program
automatically saves the background image file to the c:\SpotCam\bkgdimgs
directory.  To specify a different directory, click on the square to the right of the File
Name box and browse for a location.

! Note:  The default file location varies, depending on where you installed the SPOT
program.

10. Specify the image setup that will be associated with this background image file when
using the Background Subtract option.  The current setup is the default.  When you
open the setup, the Background Subtract option is selected.

! Note:  Fluorescence is one of the five image setups provided as a part of the SPOT
software.

11. Click on OK.
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12. Open the image setup that you specified when you saved the background image (i.e.,
Fluorescence).

− The Exposure and Image Area options are disabled (grayed).

− A checkmark appears in the Background Subtract box.

− The directory path and name of the background file that you defined in step eight
appears in the Background Subtract dialog box.

13. Either click on OK, or Cancel.

14. Move the specimen back into the field of view, and perform the image capture.

! Note:  Refer to Chapter 4, Taking a Picture, for more details on the image capture
process.

Flatfield Correct

The Flatfield Correct option is used to correct for display problems associated with
uneven intensity or coloration in your illumination, or artifacts (i.e., dust) in your optical
system.  It is used mainly with brightfield images.

The Flatfield Correct option is similar to the Background Subtract option in that it is a
process that involves two images.  In the case of flat field correction, the flatfield image
and the final image are the two images.

! Note:  Flatfield correction with the SPOT camera refers only to the correction of
uneven lighting.  It should not be confused with the correction of optical field
flatness.

To use the Flat Field Correct option, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.

2. From the Camera menu, select the Get Flat Field Image option.  The following
window appears.

3. Position the slide so that a clear part of the slide is in the field of view.
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4. Click on the Begin button.  When the program finishes computing the exposure times
and acquiring the flatfield file, the following window appears:

5. Enter a name in the File Name box.  Because flatfield image files are different for
each objective, you might want to name the the file according to the objective's
magnification (i.e., 10x).

6. Specify the image setup that will be associated with this flatfield image file when
using the Flatfield Correct option.  The current setup is the default.  When you open
the setup, the Flatfield Correct option is selected.

7. Click on OK.  If you do not specify a directory path, the program automatically saves
the flat field file to the c:\SpotCam\Fltflds directory.

! Note:  The default file location varies, depending on where you installed the SPOT
program.

8. Move the specimen back into the field of view, and perform the image capture.

! Note:  Refer to Chapter 4, Taking a Picture, for more details on the image capture
process.
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Introduction
After you have defined exposure parameters and automated adjustment options on the
Image Setup screen, you are ready to capture the image.

! Note: In many cases, the processes of defining an image setup and capturing an
image overlap.  For example, when using the Background Subtract option, as
detailed in Chapter 3, you must capture an initial image as a part of the definition
process.

While the SPOT software offers you a wide array of image capture and modification
options, as described here and in Chapter 3, the basic procedure that you will you use to
take most of your pictures is a simple process:

1. Prepare your microscope and specimen.

− Set the microscope for Koehler illumination, and set the lamp voltage to the photo
setting.

− Use a daylight filter, and insert at least one ND12 and ND6 filter into the light
path.

− Ensure that the specimen is in focus.

2. Choose an existing image setup, or define a new image setup.  Refer to Chapter 3,
Preparing to Take a Picture for more information.

3. Perform a white balance to ensure that the colors of your specimen will display
accurately.  Refer to the Compute White Balance Values section of this chapter for
more information.

4. Use the Get Image (exposure from setup) option to capture the image.

5. If necessary, focus the image, as described in this chapter.

6. Recapture the focused image.

The actual capture of a digital image (taking the picture) is the part of the process that is
most closely related to traditional photographic techniques.  In the SPOT software,
capture options are accessed via the Camera menu, which has three types of capture
options:

§ Capturing Initial and Final Images
§ Captures for Preparation and Modification
§ Frame and Focus Options

Each of these options is discussed in the sections that follow.

! Note:  Initialize, the first option on the Camera menu, is discussed in Chapter 2,
Navigating the SPOT Software.



Ch. 4 - Taking a Picture Capturing Initial and Final Images

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 50

Capturing Initial and Final Images

The SPOT software offers two primary image capture options:

§ Get Image (exposure from setup)
§ Get Image (last used exposure)

Get Image (exposure from setup)

The Get Image (exposure from setup) option captures an image according to the
specifications in the Current image setup.  Press [F 12] to view the current image setup.
This option is used after you have defined an image setup and have prepared the
microscope and specimen.

To capture an image using the current image setup, follow these steps:

1. Determine or define the image setup that you want to use, and set it as the Current
setting (i.e., select the Current option from the Image Setups dialog box).

2. From the Camera menu, select the Get Image (exposure from setup option).

Shortcuts:  To get an image, you can also use one of the following two methods:

− Press [F 9].

− Click on the Get Image (exposure from setup) button on the Toolbar:

3. The Get Image status window, which indicates the name of the image setup you are
using, as well as the status, appears, as shown here:

The initial series of clicks is the camera sampling the light source in order to compute
the exposure times.
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4. A second series of three clicks begins, as the camera takes three pictures.  A status bar
indicator displays as each (red, blue and green) picture is taken, along with the gain
that it is using for the picture:

The Status messages that appear for each image capture are as follows:

a) Computing Exposure – The camera is sampling brightness levels in the image in
order to determine proper exposure times.

b) Getting Red Image – The camera is downloading the red image to the PC.

c) Getting Green Image – The camera is downloading the green image to the PC.

d) Getting Blue Image – The camera is downloading the blue image to the PC.

e) Processing – The camera is preparing to display the image.

! Note:  If the exposure time for any one of the values (i.e., red, green, or blue) is
more than two seconds, a countdown clock displays the time.

5. The newly captured image appears on screen for modification, editing, or annotation.
Following an image capture, several noticeable changes take place in the appearance
of the main SPOT screen:

− The Edit and View menus become available.
− The editing, save, and print related toolbar buttons are available (no longer

grayed).
− The Get Image (last used exposure), Set Image Region, and Recall Previous

Exposures options on the Camera menu are available (no longer grayed).

Get Image (last used exposure)

The Get Image (last used exposure) option works in exactly the same way as the Get
Image (exposure from setup) option.  The difference in the two options is that the Get
Image (last used exposure) option uses the exposure times and gain from the previous
exposure, and is thus faster because it skips the initial auto-exposure sequence.  This is
convenient in cases where you are satisfied with the appearance of an image and want to
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use the same settings to capture a similar image during the same session. If you close the
software, and re-open it, the Get Image (last used exposure) option is unavailable.

To use the Get Image (last used exposure) option, follow these steps:

1. Prepare the microscope and specimen for the next image capture.

2. From the Camera menu, select the Get Image (last used exposure) option.

Shortcuts:  To capture an image with the last used exposure option, you can also use one
of the following two methods:

− Press [F 8].

− Click on the Get Image (last used exposure) toolbar button:

3. The Get Image status window appears.  It only displays the exposure times and the
gain because the camera no longer needs to sample the image brightness.  This
shortens the exposure process.

Captures for Preparation and Modification
The following options allow you to customize the image capture process through the
following pre and post-exposure adjustments:

§ Set Image Region

§ Compute Exposure

§ Recall Previous Exposure

§ Compute White Balance Values

§ Get Background Image

§ Get Flatfield Image

! Note:  Because they are used prior to a final image capture, several of these
options are discussed as a part of the image setup process.  In such cases, the text
of the manual refers you back to the appropriate section of Chapter 3, Preparing
to Take a Picture.

Set Image Region

Use the Set Image Region option to select a specific portion of the CCD chip (i.e., the
image).  Cutting out a specific part of an image is useful for two reasons:

− The download time for a smaller images is shorter.
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− The file size for a region is smaller and easier to manage.

To use the Set Image Region option, follow these steps:

2. Position the cursor at the upper left edge of the image region that you want to capture.

3. Click on the left mouse button and use the mouse to drag the cursor across the screen.
A dotted border appears around the region that you select.

4. From the Camera menu, select the Set Image Region option.  The Image Region
window displays the pixel locations for the borders of the region that you selected, as
illustrated below:

5. Click on OK to save the region values to the current image setup, or select a different
image setup.  The region values are now saved to the image setup.

! Note:  The image setup will automatically use the region values that you specified
for subsequent image captures.  Refer to Chapter 3, Preparing to Take a Picture
for other region capture techniques.

6. Select either the Get Image (exposure from setup) option or the Get Image (last used
exposure) option.  The new image capture displays only the region that you selected.

Compute Exposure

The Compute Exposure option determines the correct red, green, and blue exposure times
for an image, as well as the gain.  This allows you to avoid the auto-exposure sequence
that takes place each time that you use the Get Image (exposure from setup) option.
Using the Compute Exposure option also cause two changes to your current image setup:

§ The computed exposure values are added to your current image setup.

§ The current image setup, if set to Auto-Exposure, is changed to User-Defined.
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To use the Compute Exposure option, follow these steps:

1. From the Camera menu, select the Compute Exposure option.

Shortcuts:  To compute exposure values, you can also use one of the following two
methods:

− Press [F 10].

− Click on the Compute Exposure values button on the toolbar:

2. The Compute Exposure window appears as shown below:

3. For your review, the Compute Exposure window displays the image setup options
(for the current setup) that directly affect the computation.  The entries for these
options can be modified from this window, but if you do so, you also change the
current image setup.  If you want to save the exposure times to a different image
setup, enter the settings for that setup.

! Note:  For information on entering Image Type, Auto-Gain Limit, Adjustment
Factor, and White Balance, refer to Chapter 3, Preparing to Take a Picture.

4. Click on the Begin button.  The Status message changes to Computing exposure…
You should hear a series of clicks as the camera samples the light.
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5. When the camera finishes, the Exposure window displays the values, as illustrated
here:

6. Select an image setup from the Save to Setup scroll bar.  The current image setup
should appear as the default.

! Note: Saving the exposure values to an image setup changes the setup from Auto-
Exposure to User-Defined Exposure.

7. Click on OK.  When you open the Image Setup window, the new exposure value(s)
should display.

8. Select the Get Image (exposure from setup) option to capture the image using the new
exposure values.

Recall Previous Exposure

Use the Recall Previous Exposure option to assign the exposure times and gain from your
last image capture to an image setup.  This feature is helpful when you determine that a
specific combination of exposure times and gain work well for a certain type of picture,
because you can then assign the exact values to the image setup.  The Recall Previous
Exposure feature is available only after you have taken a picture.
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To use the Recall Previous Exposure option, follow these steps:

1. After capturing an image, select the Recall Previous Exposure option from the
Camera menu.  The Exposure window displays the values from the last image, as
illustrated below:

! Note:  If you change the current image setup, the Recall Previous Exposure option
will be unavailable until you take another picture.

2. Select an image setup from the scroll bar and press OK, or click on the Cancel button
to exit the window without saving the exposure values.

3. Use the Get Image (exposure from setup) to capture an image with the new Exposure
and gain values.

Compute White Balance Values

White balance is the ratio of red, green, and blue exposure times necessary to achieve the
proper color rendition for an image.  Many factors impact the coloration of an image
capture, including lamp voltage, coloration of the slide, and coloration of the micro-
scope’s objectives.  In order to minimize the impact of these factors, the Compute White
Balance feature samples the color of your light source and calculates the exposure values
needed to produce images where the white areas are white and the color areas are true.

You should perform a new white balance calculation in the following cases:

§ When you start a new image capture session.

§ When you change the lamp voltage.

§ When you switch to a different objective on the microscope.

When you open an image setup, the Image Setup screen displays the default white
balance values for that Setup, which are the values that were last saved to the Image
Setup.  If you capture an image without computing a new white balance, SPOT uses the
default values.



Ch. 4 - Taking a Picture Captures for Preparation and Modification

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 57

To compute new white balance values for an image setup, follow these steps:

1. Set the illumination and the objective that you will use for the image capture.

2. Position the slide so that the specimen is not in the field of view.  This gives the
camera a reference point to use for a white value.  Different specimens require
different points of reference, as described in the following table:

Sample Type Point of Reference

Transmitted light (non-fluorescent) Clear part of the slide

Reflected light (non-fluorescent) Mirror

Macroscopic White piece of paper

Because fluorescent images are darkfield images (i.e., the background is darker than
the specimen), white balances are not necessary.

3. From the Camera menu, select the Compute White Balance Values option, or use the
toolbar and click on the Compute White Balance Values button:

4. The Compute White Balance window appears, as follows:

5. Click on the Begin button to start the calculation.  The Compute White Balance
window displays the status message Computing white balance values.  You should
hear a series of clicks as the camera samples the light.
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6. When the camera finishes calculating the white balance values, the following window
appears:

7. The computed white balance values appear, along with the Save to Setup option.  The
camera automatically saves the computed values to the current active setup (i.e., the
image setup that appears in the scroll bar at the bottom right corner of the screen).

! Note:  Due to the inherently poor blue light sensitivity of CCD chips, the blue
value is often much higher than the red and green values.

8. To change the setup that the new white balance values are saved to, click on Save to
Setup scroll bar, and select a setup from the list.

9. Click on OK.

10. The program returns to the main screen.

11. To edit the white balance values that you saved, open the image setup (i.e.,
Brightfield from the previous example).  The values should appear in the Red, Green,
and Blue selection bars. Edit the values as needed.

Get Background Image

The Get Background Image option is the first step in the background subtract process
described in Chapter 3, Preparing to Take a Picture.  The Background Subtract option
allows you to rid your images of the background glow that is sometimes seen in
fluorescence images.  Sometimes, you will notice this glow while looking at the
specimen under the microscope; other times, you will only notice it after you have
already captured an image.
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The following illustration shows the effect of a background subtraction on a fluorescent
image:

Figure 1:  Fluorescent sample prior to background
subtraction

Figure 2: Fluorescent sample after background
subtraction

When you use the Get Background Image option, you are taking the first of the two
pictures used for a background subtraction.  This image is the one that the camera
subtracts during the final image capture process.

For a detailed description of the steps involved in the background subtract process, refer
to Chapter 3, Preparing to Take a Picture.

Get Flatfield Image

The Get Flatfield option is the first step in the Flatfield Correct process described in
Chapter 3, Preparing to Take a Picture.  The Flatfield Correct process corrects display
problems associated with uneven lighting or artifacts (i.e., dust) in your optical system.  It
is used mainly with brightfield images.  The Flatfield Correct option is similar to the
Background Subtract option in that it is a process that involves two images.  In the case
of flatfield correction, the flatfield image and the final image are the two images.

! Note:  Flat field correction with the SPOT camera refers only to the correction of
uneven lighting.  It should not be confused with the correction of optical field
flatness.

For a detailed description of the steps involved in the flatfield correct process, refer to
Chapter 3, Preparing to Take a Picture.



Ch. 4 - Taking a Picture Framing and Focusing

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 60

Framing and Focusing

The SPOT framing and focusing features enable you to position and focus images from
an on-screen perspective, as opposed to through the microscope.  When you frame or
focus an image, the SPOT Camera takes successive black and white pictures as you
adjust your microscope’s controls, thereby updating the image at a rate that you specify,
according to image brightness and desired resolution.

Frame

The Frame option allows you to ensure that an image is correctly positioned before
capturing an image.  In other words, the Frame option enables you to ensure that
everything that you want to appear in the final image will be there.  Consider the
following image capture:

The image captured in the above diagram is off-center.  Using the Frame option, you can
adjust the  position of the image without having to look through the microscope, recap-
ture the image, and determine if it displays correctly. The Frame option enables you to
adjust the specimen’s position using the on-screen image as a reference.  The Frame
option can also be used before you have captured an image.
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To use the frame option follow these steps:

1. With the image in question on-screen, either select the Frame option from the Camera
menu, or click on the Frame toolbar button:

2. The Frame window appears on top of the image.

3. Select either the Red, Green, or Blue filter option, depending on the predominant
color in the specimen.  Different colors will provide different levels of contrast.  The
best way to determine a color for Framing (or focusing) a specimen is to preview it by
clicking on the color box.

4. Select a shutter speed limit.

The Speed option on the Frame window sets a lower limit on the update rate of the
framing window.  When you Frame an image, the camera captures black and white
images to update the position as you move the x-y stage adjustment controls.  Ideally,
the speed should be as fast as possible (i.e., the Fast setting) so that the update rate is
quick and the lag time between making the  adjustments and seeing the update is less
noticeable.  However, the brightness of the initial image plays an important part in
selecting an update rate.  Dimmer images, for example, require slower updates in
order to produce high quality images.

! Note:  Refer to Table 1 in the Focus section of this chapter for a comparison of
speed and image quality.

5. After you have selected an update speed setting, click on the Begin button.  The
image appears in the Frame window, and the Camera begins clicking.  The initial
series of clicks is the camera determining the correct exposure, as it does with the Get
Image (exposure from setup) option.

6. Wait for the initial clicks to end.  When the initial clicking has ended, you can begin
adjusting the image position.

7. When the image is positioned as it should be, click on the Stop button.

8. Click on the Close button.

9. From the Camera menu, select the Get Image (exposure from setup) option.
Alternatively, you can either click on the associated toolbar button, or press [F 9].

10.  The newly adjusted image capture appears.
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Focus

The Focus feature, like the Frame feature, allows you to focus on an image directly from
the screen.  You do not need to look into the microscope after you have captured the
initial image.  As with the Frame option, the Focus option can be used either after you
have already captured an initial image or prior to your first image capture.

! Note:  If you focus on an image before you perform the initial capture the focus is
limited to the center of the CCD chip.  Focusing after the initial capture, enables
you to select a specific part of the image (i.e., the CCD chip).

To focus on an image, follow these steps:

1. Either select the Focus option from the Camera menu, or click on the Focus toolbar
button:

2. A rectangle appears, superimposed on the center of the image.  This rectangle defines
the area that you will focus on.

! Note:  If you focus on the specimen before the initial image capture, the Focus
window appears instead of the rectangle.

3. Move the rectangle to the area of the image that you want to focus on.  To move the
rectangle, use one of the following techniques:

− Left click and drag the rectangle to the appropriate position.

− Left click on the area of the image that you want to focus on.  The rectangle
moves to the position that you click on.

4. To open the Focus window and select the focusing options, either double click or
right click on the rectangle.  The focus window appears superimposed on the image,
with the area that you selected in the frame.

5. Select a Filter Color, either Red, Green, or Blue, depending on the predominant color
in the specimen.  Different colors will provide different levels of contrast.  The best
way to determine a color for focusing (or framing) a specimen is to preview it by
clicking on the box.

6. Select a Binning option.

Binning, as described in Chapter 3, Preparing to Take a Picture, combines adjacent
pixels on the CCD chip, thereby reducing the number of pixels used in the image
capture.  Binning is useful when you have dim images and want to increase
sensitivity and reduce the download time, which can be lengthy with very dim
images.  However, as sensitivity increases and download time decreases, image
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resolution also decreases.  All of these factors should be considered when you select a
binning option.

The binning option on the Focus window defaults to the setting of the current image
setup.  However, you can override this setting from the Focus window by clicking on
a different setting.  The camera will use the last specified option, either from the
current image setup or the Focus window.

7. Select a shutter speed limit.

The Speed option on the Focus window sets a lower limit on the update rate of the
framing window.  When you focus an image, the camera is capturing black and white
images to update the image area as you move the focus controls.  Ideally, the speed
should be as fast as possible (i.e., the Fast setting) so that the update rate is quick and
the lag time between focusing and seeing the updated image is less noticeable.
However, the brightness of the initial image plays an important part in selecting an
update rate.  Dimmer images, for example, require slower update rates in order to
produce the image quality needed for critical focusing.  The table below illustrates the
variable relationship between shutter speed, image quality, and image brightness:

Shutter Speed Image Quality Image Brightness Variable

Slowest (approx. 1 frames/2 secs.)

Slow (approx. 1 frames/sec.)

Medium (approx. 3 frames/sec)

Fast (approx. 5 frames/sec)

Highest

�

�

Lowest

Dimmest

� �

� �

Brightest

8. Modify the Exposure Adjustment as needed.  Enter a value between .25 and 8, or
move the selection bar to the desired position.  The contrast of the image area changes
as you move the bar.

! Note:  When you open the Focus window, the last entered Exposure Adjustment
value appears.  Although Exposure Adjustment on the Focus window is the same
concept as Adjustment Factor on the Image Setup window (see Chapter 3), it is
not linked to the value associated with the current image setup.

The Exposure Adjustment option enables you to overexpose or underexpose (darken
or lighten) the area of the image that you are focusing on.  This feature is designed to
help you customize your image captures.  In many cases, for example, an image has
varying levels of brightness, and you might want to lighten or darken a specific area.

9. Click on the Begin option. The initial series of clicks is the camera determining the
correct exposure, as it does with the Get Image (exposure from setup) option.

10. Wait for the initial clicks to end.  When the initial clicking has ended, you can begin
focusing the image.

To interrupt the process and focus on a different area, click on the Reposition button.
Use the focusing rectangle to select a different area.
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11. When the image appears as you want it to, click on the Stop button.

12. Click on the Close button.

13. From the Camera menu, select the Get Image (exposure from setup) option.
Alternatively, you can either click on the associated toolbar button, or press [F 9].

14. The focused image appears.
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Introduction
After capturing an initial image, you can choose from a variety of viewing, editing, and
annotation options that allow you to customize the appearance of the final image.  These
features are particularly useful when preparing images for a formal presentation.  All of
these features are accessed through two menus which are available only when an image is
on-screen.

§ View
§ Edit

The options for each of these menus are discussed in the following sections.

View
The View menu enables you to view all or part of an image in either magnified (zoomed
in) or non-magnified (zoomed out) modes.  The View menu options include the
following:

§ Fit in Window
§ Zoom
§ Show Grid Lines
§ Show Pan Window
§ Show Measurements

Each option, with the exception of Show Measurements, is discussed in the sections that
follow.

! Note:  The Show Measurements option is discussed in Chapter 6, Calibration and
Measurement.

Fit in Window

The Fit in Window option allows you to view the whole image, regardless of the window
size.  Typically, reducing the size of a window also cuts off part of the image.  The Fit in
Window option solves this problem by automatically resizing the image so that it is
always the same size as the image.  The Fit in Window option is particularly useful when
you want to view different images side by side.

! Note: The View menu options supplement the standard Windows viewing options
(i.e., Cascade, Tile Horizontal, etc…) that are found on the Window menu.  Refer to
the Windows on - line help for more information on these options.

In the picture on the following page, two image captures are open.  The right image
capture displays the entire image (i.e., the entire image was selected), while the left
capture displays only a part of the original image:
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To use the Fit to Window option, follow these steps:

1. Select (i.e., click on) the image that you want to modify.

2. From the View menu, either click on the Fit in Window option, or press [Ctrl F].

Zoom

The Zoom feature enables you to magnify or de-magnify an image by a factor of two
over the following range:

§ Zoom in - 16x

§ Zoom out - 1/16x

All of the standard save, view, and edit options, with three exceptions, can be performed
while the program is in zoom mode.  The exceptions are:

§ Show Measurements
§ Annotate
§ Crop

To use the Zoom feature, do the following:

1. From the View menu, select the Zoom option.  The cursor changes to a magnifying
glass, and the Zoom toolbar button becomes active.

The precise reference point for the zoom location is indicated by the white dot in the
center of the magnifying glass.  The row and column numbers at the bottom of the
screen indicate the exact position of the white dot as you move the magnifying glass
over the image.

Shortcuts: You can also use one of the following two methods to zoom in on an image:

− Press [Ctrl Z]

− Click on the Zoom toolbar button:

2. Use the mouse to zoom in or zoom out:
a) Position the mouse over the center of the area that you want to zoom in on.

b) Either left click to zoom in 2x, or right click to zoom out 2x.

To return to the normal view mode, de-select the Zoom option.

! Note:  The Zoom feature works in conjunction with the Show Pan Window option,
which allows you to see where you are in relation to the larger image while zoomed
in.  The Show Pan Window option is discussed later in this chapter.
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Show Grid Lines

The Show Grid Lines option clearly defines pixel borders, which are often invisible in
low contrast areas of an image.  Clearly defined borders help in positioning the cursor at
an exact row and column location (i.e., using the readouts at the bottom of the screen),
which then allows you to view the brightness value for the individual pixel.

The following is a section of a magnified image with the show grid lines option turned
on:

All of the standard save, view, and edit options, with three exceptions, can be performed
while the software is in the zoom/show grid lines mode.  The exceptions are:

§ Show Measurements

§ Annotate

§ Crop

To use the Show Grid Lines option, follow these steps:

1. Position the magnifying glass in the center of the area that you want to zoom in on.

2. Zoom to either 8x or 16x.

3. Grid lines appear around each pixel.



Ch. 5 - Viewing, Editing, and Annotating Images View

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 70

Show Pan Window

The Show Pan Window option enables you to navigate around an image while zoomed in
at high magnification. Typically, moving to a new point while in high magnification
involves several steps:

1. Zooming in to the first area of interest.

2. Zooming out to determine where you are.

3. Determining a new area of interest.

4. Re-zooming in to the new area of interest.

This tedious process is replaced by the pan window.  When you select the Show Pan
Window option, a smaller version of the image appears with a color negative over the
area of the image that you are zoomed in on.  To move to a new area of the image while
zoomed in, either drag the colored rectangle to the new location, or left click on the
location.

To use the pan window, follow these steps:

1. From the View menu, select the Show Pan Window option.

Shortcuts: You can also use one of the following two methods to bring up the pan
window:

− Press [Ctrl W]

− Click on the Show Pan Window  toolbar button:

! Note:  The pan window can be opened at any level of magnification.
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2. The pan window appears, superimposed upon the image.  The following illustration
shows the pan window as it is used when you zoom in on an image:

3. When you position the cursor on the image in the pan window, it changes from a
magnifying glass to a four arrow pointer.  To move to a different area of the text,
either left click on the rectangle and drag it to the new location, or left click on the
new location.

4. When you are finished viewing the image, close the Pan Window.

Edit
The Edit menu contains several different categories of editing options, as illustrated in the
following table:

Editing Category Menu Option

Basic Editing Functions Undo
Copy to Clipboard

Image Sizing and Position Resize
Flip Horizontal

Flip Vertical
Rotate Right
Rotate Left

Crop
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(cont.)

Editing Category Menu Option

Image Quality Adjust RGB
Adjust HSL

Make Negative
Convert to Gray Scale

Sharpen
Smooth

Filter Noise

Customizing Images Combine Images
Change Bit Depth

Merge Images
Annotate

The following sections correspond to the editing categories above.

Basic Editing Functions

The Edit menu contains two functions that are common to most operating systems.

§ Undo
§ Copy to Clipboard

These functions are described below.

Undo

Use the Undo option to undo the last edit that you made.  Unlike some Windows
programs, you cannot undo more than one level of edits.

To undo an edit, select the Undo option from the Edit menu.

Copy to Clipboard

Use the Copy to Clipboard option to copy all or part of an image onto the clipboard for
insertion into another program.  The Copy to Clipboard feature is identical to the
Windows Copy command [Ctrl C].

To use the Copy to Clipboard option, follow these steps:

1. Left click and drag on the image until the dotted rectangle covers the area of the
image that you want to copy.  If you select the Copy to Clipboard option without
"cutting out" a specific portion of the image, the program selects the entire image by
default (i.e., the dotted rectangle surrounds the entire image).
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2. Either select the Copy to Clipboard option from the edit menu, or press [Ctrl C].  The
image is now stored on the Windows clipboard for pasting into another application.

3. Open the application that you want to paste the image into, and select from the
available pasting options.

Image Sizing and Position

The following Edit menu options provide you with a means of editing an image's size and
screen position.  In addition to allowing you to size an image as needed, the Flip and
Rotate commands enable you to match the on-screen orientation of a specimen to the
orientation as seen through the microscope.

Resize

Use the Resize option to reduce or enlarge an image.  When you reduce or enlarge an
image, the resolution and file size change accordingly.  The SPOT program maintains
aspect ratio so enlarged and reduced images will not be distorted.  When you reduce or
enlarge an image, keep the following in mind:

§ Reduction - Resolution (number of pixels) and file size decrease.
§ Enlargement - (number of pixels) and file size increase

Thus the trade off for higher resolution images is increased file size.  The resize option
lets you specify the percentage by which you want to increase or decrease the image size.
The program reads the red, green, and blue brightness values for the original (1315 x
1035 pixel) image and uses those values to create a new image that is reduced or enlarged
by the percentage that you specify.

Some circumstances where you might want to enlarge or reduce an image include:

§ You captured an image with a low magnification objective (i.e., 5x or below) - In this
case, enlarging the image adds pixels, which helps to smooth out the pixellation of
high contrast, fine detail.  This makes it easier to view and interpret the structure of
the details.

§ You want to save file space and resolution is not the primary concern - In this case,
reducing the image reduces the file size.
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To resize an image, follow these steps:

1. From the Edit menu, select the resize option.  The Resize Image window appears as
follows:

2. Do one of the following:

− If you want to change the size of an image by a specific percentage, type in a
value between 10 % and 200 %.  The Width and Height values change according
to the percentage that you specify.

− If you want to specify the dimension in pixels, enter a number in either the Width
or the Height box.  The SPOT program automatically calculates the dimension not
entered in order to maintain the proper aspect ratio.

If you enter a number that is too large or too small, the program displays an error
message.

3. Click on OK to resize the image.  The newly sized image replaces the original image
on the screen.

! Note: If you want to create two differently sized images of an image for
comparison purposes, use the Save As [Ctrl A] command to save the resized
image with a different file name.

Flip Horizontal

Use the Flip Horizontal command to flip an image from right to left.

Flip Vertical

Use the Flip Vertical command to flip an image from top to bottom.

Rotate Right

Use the Rotate Right command to rotate an image clockwise in 90 degree increments.
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Rotate Left

Use the Rotate Left command to rotate an image counter-clockwise in 90 degree
increments.

Crop

Use the Crop feature to cut out a portion of an image.  To crop an image, follow these
steps:

1. Use the mouse to left click and drag on an image to select the area of the image that
you want to crop.  A dotted rectangle defines the area.

2. From the edit menu, select the Crop option.  The cropped version of the image
appears on the screen.

! Note: If you want to create cropped and non-cropped versions of an image for
comparison purposes, use the Save As [Ctrl A] command to save the cropped
image with a different file name.

Image Quality

The image quality editing features provide you with a wide array of powerful and easy to
use tools for changing the appearance of an image after it has been captured.  These tools
enable you to enhance the appearance of an image in ways that are not possible with
conventional photography.

Adjust RGB/Adjust HSL

The SPOT software gives you precise control over the coloration, brightness, and contrast
of your final image.  The Adjust RGB (Red Green Blue) and Adjust HSL (Hue Saturation
Luminance) options are two different ways to make use of SPOT's robust image editing
features.

In imaging terminology, RGB and HSL are two different color spaces.  A color space is
any coordinate system that is used to mathematically represent color.

§ The RGB color system operates by assigning a red, green, and blue value to each
pixel in an image.  This is the method that color computer monitors use to display
images.

§ The HSL color space, on the other hand, is a more intuitive model, based on the three
attributes that are common to all colors: hue, saturation, and luminance.  Instead of
assigning a red, blue, and green value to each pixel, the HSL color space assigns a
value for each color attribute (i.e., hue, saturation, and luminance).  These attributes
are defined as follows:
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− Hue - Hue is the designation for the actual color, as distinguished from others in
the color spectrum.  Hue is derived from a color wheel and is expressed in the
color's angular location (in degrees) on the wheel.  (i.e., +180° to -180° for the
SPOT software).

− Saturation - Saturation is the proportion of perceived pure hue in the color.
Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100,
where zero equals pure gray and 100 equals pure hue (i.e., day glow).

− Luminance - Luminance is the relative brightness or darkness of a hue, or how
white or black a given color is.  Luminance (in the SPOT software) is measured
on a numerical scale of 0 to 100, where zero equals pure black and 100 equals
pure white.

! Note: A saturated color starts out as black at a luminance of 0, reaches full
brightness as a saturated color at a luminance of 50, and then transitions through
lighter pastel shade to white at a luminance of 100.

Adjust RGB or Adjust HSL - Which One Should I Use?

Because the Adjust RGB and Adjust HSL options perform the same types of editing tasks
but in different ways, they are suited to different image types.  The following table
compares the methodologies and lists some situations in which either the RGB or the
HSL color space might be preferable to use in image editing.

RGB HSL
Color Translation

None.

Editing in the RGB color space operates
directly on the red, green, and blue values read
by the camera.

1. RGB values are translated into the HSL
color space.

2. Edits are made.
3. HSL values are translated back to the RGB

color space.

Usage

RGB editing functions are less intuitive than
those done in the HSL color space.

Using hue, saturation, and luminance is a more
intuitive way to edit colors than working directly
with RGB values.

Guidelines

Use RGB:
§ When the colors in the bright areas of an  image

need to remain saturated.  HSL editing can
cause bright areas in images with simple red,
green, and blue shades to turn pastel.

§ With images that are composed mainly of simple
primary colors, such as fluorescence samples.

§ With monochrome images.  Monochrome
images can only be edited in RGB mode.

Use HSL:
§ With editing functions that work solely

on the luminance value.  This includes
contrast, gamma, and stretch.  Editing
luminance does not affect the hue or
saturation of darker colors.  RGB
editing tends to give darker colors a
"washed out" appearance.

§ With brightfield and macro images
that have many subtle shades of
color.
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The Adjust RGB and Adjust HSL options are each comprised of several image editing
functions that are described in the upcoming sections.  Because these two menu items
contain parallel functions (activated via different color spaces), the similar options are
described in pairs.  RGB or HSL appears parenthetically after the heading to indicate
which menu item the option is associated with.  The table below lists the parallel RGB
and HSL functions:

Adjust RGB Adjust HSL

Adjust Brightness (additive)
Adjust Brightness (multiplicative)

Adjust Hue, Saturation, and Luminance

Adjust Contrast Adjust Contrast
Adjust Gamma Adjust Gamma

Stretch Bright and Dark Level Stretch Bright and Dark Level
Adjust Histogram Adjust Histogram

Adjust Brightness (additive) (RGB)

Use the Adjust Brightness (additive) option to lighten or darken an entire image.  This
function adds or subtracts the specified number(s) from the red, green, and blue values
for every pixel in the image. Because this is an additive function, it affects bright and
dark areas equally.

Using the Adjust Brightness (additive) feature you can change an image's brightness
either by adjusting all three values (i.e., red, green, and blue) together, or adjusting each
value individually.

To use the Adjust Brightness (additive) function, follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Brightness (additive).  The
Additive Brightness Adjust window appears, with a smaller preview version of the
open image:

When you open the Additive Brightness Adjust window, Lock RGB is selected as the
default.
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2. To change the brightness of an image, do one of the following:

− To modify an image's brightness equally for red, green, and blue values, enter a
number in any one of the three boxes, or use a slider bar to specify a number
between -255 and 255.

− To modify an image's brightness by specifying separate red, green, and blue
values, deselect the Lock RGB box, and enter a value for each color.

3. Click on OK.  The new image appears on screen.

Adjust Brightness (multiplicative) (RGB)

Use the Adjust Brightness (multiplicative) option to make the bright areas of an image
brighter or darker.  This function multiplies the red, green, and blue values for every pixel
in the image by the number(s) that you specify.  Because this option is multiplicative, it
affects bright areas more than dark areas.  Like the Adjust Brightness (additive) option,
the multiplicative option enables you to either adjust the RGB values together or as
individual units.

To use the Adjust Brightness (multiplicative) function, follow these steps;

1. From the Edit menu, select Adjust RGB and Adjust Brightness (multiplicative).  The
Multiplicative Brightness Adjust window appears, with a smaller preview version of
the open image:

When you open the Additive Brightness Adjust window, Lock RGB is selected as the
default.

2. To change the brightness of an image, do one of the following:

− To modify an image's brightness equally for red, green, and blue values, enter a
number in any one of the three boxes, or use a slider bar to specify a number
between 0 (darkest) and 5 (brightest).

− To modify an image's brightness by specifying separate red, green, and blue
values, deselect the Lock RGB box, and enter a value for each color.
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3. Click on OK.  The new image appears on screen, replacing the original image.

Adjust Hue, Saturation, and Luminance (HSL)

The Adjust Hue, Saturation, and Luminance option enables you to change the HSL
values for an image.  The process works by first converting the RGB values for each
pixel in the image to HSL values.  After you make the adjustments, the program then
converts the HSL values back to RGB color space values.

To change the HSL values for an image, follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Hue, Saturation, and Luminance.
The following window appears:

2. Either type in the HSL values, or use the slider bars to select the values.  Each value
uses its own scale, and must be entered separately.  The thumbnail version of the
image changes as you make the adjustments.

− Hue - Enter an angle value between -180° and 180°.  This number represents the
amount that the color wheel is rotated for each pixel in the image.

− Saturation - Enter a number between -100 and 100.  This number is added to the
saturation value (i.e., a number between 0 - pure gray and 100 - day glow) of each
pixel in the image.

− Luminance - Enter a number between -100 and 100.  This number is added to the
luminance value (i.e., a number between 0 - pure black and 100 - pure white) of
each pixel in the image.

! Note: The scales used to measure HSL values are not standardized.  Thus the
scales used by the SPOT software might differ from those of other programs.

3. Click on OK.  The new image appears on screen, replacing the original image.



Ch. 5 - Viewing, Editing, and Annotating Images Edit - Image Quality

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 80

Adjust Contrast (RGB)

Use the Adjust Contrast option to exaggerate or subdue the differences between the
bright and dark areas in an image.  The Adjust Contrast option, when accessed from the
Adjust RGB menu item, enables you to make adjustments to the red, green, and blue
values either together, or as individual units.

To use the Adjust Contrast option, follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Contrast.  The Contrast Adjust
window appears, with a smaller preview version of the open image:

When you open the Contrast Adjust window, the Lock RGB is selected as the default.

2. To change the contrast of an image, do one of the following:

− To change the contrast equally for red, green, and blue values, enter a number in
any one of the three boxes, or use a slider bar to specify a number between 0 (pure
gray - no contrast) and 5 (maximum contrast).

− To modify an image's contrast by specifying separate red, green, and blue values,
deselect the Lock RGB box, and enter a value for each color.

3. Click on OK.  The new image appears on screen, replacing the original image.

Adjust Contrast (HSL)

The Adjust Contrast (HSL) option, like the Adjust Contrast (RGB) option, exaggerates or
subdues the differences between the bright and dark areas in an image.  Unlike the Adjust
Contrast (RGB) process, the Adjust Contrast (HSL) process works only on the luminance
values for an image as opposed to the specific red, green, and blue values.  Because the
HSL contrast adjust works only on the luminance of an image, it will not affect hue or
saturation.  Working in the RGB mode, on the other hand affects hue, saturation, and
luminance, and can therefore cause unexpected changes in the appearance of an image.
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To use the Adjust Contrast (HSL) option, follow these steps:

1. From the Edit menu, select Adjust HSL and Adjust Contrast.  The Contrast Adjust
window appears, with a smaller preview version of the open image:

2. Enter a value between .1 and 4, or use the slider bar to select a value.  The thumbnail
preview of the image changes as you adjust the value.

− To exaggerate the contrast of an image, enter a value above one (the base value).

− To subdue the contrast of an image, enter a value below one (the base value).

3. Click on OK.  The new image appears on screen, replacing the original image.

Adjust Gamma (RGB)

Use the Adjust Gamma option to smoothly lighten darker areas of an image without
burning out bright areas or lightening black areas.  The Adjust Gamma option is
particularly useful when capturing images with a wide dynamic range, meaning the range
of brightness values recorded by the CCD chip for a particular image.  Some examples of
wide dynamic range images include:

§ Fluorescence specimens

§ Macroscopic items with glints, such as printed circuitry.

When the bright areas of these types of images are correctly exposed, the darker areas are
sometimes so dark that they are, in effect, invisible.  Using the Adjust Gamma option can
remedy this problem.
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Gamma adjustment corrects an image by creating a new version of the original.  To
create the new image, the Adjust Gamma (RGB) function reassigns the RGB values of
each pixel in the image according to the curve in the following graph:
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The above graph demonstrates some of the basic principles of gamma adjustment:

§ Black (pixel value = 0) remains black at all gamma values.

§ White (pixel value = full scale) remains white at all gamma values.

§ Gamma values greater than one lift the darker areas of the original image into the
brighter areas of the new image.

§ A gamma curve is smooth: there are no unexpected jumps or cutoffs.  This means that
when viewing a gamma adjusted image, you will be able to see the details (intensity
differences) in both the black and white areas of the image.
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To use the Adjust Gamma option, follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Gamma.  The Gamma Adjust
window appears as follows:

When you open the Gamma Adjust window, Lock RGB is selected as the default.

2. To gamma adjust the image, do one of the following:

− To adjust the gamma equally for red, green, and blue values, enter a number in
any one of the three boxes, or use a slider bar to specify a number between .1 and
4.

− To gamma adjust an image by specifying separate red, green, and blue values,
deselect the Lock RGB box, and enter a value for each color.

! Note: The ability to deselect the Lock RGB box and enter specific RGB values
distinguishes the use of the Adjust Gamma menu option from the Gamma Adjust
option on the Image Setup window (see Ch. 3 - Preparing to Take a Picture).

3. Click on OK.  The new image appears on screen, replacing the original image.

Adjust Gamma (HSL)

The Adjust Gamma (HSL) option works in exactly the same way as the Adjust Gamma
(RGB) option described in the previous section.  For more details on how the gamma
adjustment process works, refer back to this section.

Like the Adjust Gamma (RGB) option, the Adjust Gamma (HSL) option allows you to
smoothly lighten darker areas of an image without burning out bright areas or lightening
black areas.  This is useful when modifying images with a wide dynamic range, meaning
the range of brightness values recorded by the CCD chip.
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Unlike the Adjust Gamma (RGB) option, Adjust Gamma (HSL) works only on the
luminance value for an image as opposed to the specific red, green, and blue values.
Because the HSL gamma adjust works only on the luminance of an image, it will not
affect hue or saturation.  RGB gamma adjustments, on the other hand, can affect hue and
saturation as well as luminance, and this sometimes leads to color shifts and/or a washed
out appearance in the adjusted image.

To use the Adjust Gamma (HSL) option, follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Gamma.  The following window
appears:

2. Enter a value between .1 and 4, or use the slider bar to select a value.  The thumbnail
preview of the image changes as you adjust the value.

− To lighten the mid-tones of an image, enter a gamma value above one.

− To darken the mid-tones of an image, enter a gamma value below one.

3. Click on OK.  The new image appears on screen, replacing the original image.

Stretch Bright and Dark Level (RGB)

The Stretch Bright and Dark Level (RGB) option stretches the darkest level in an image
to 0 (black) and the brightest level to full scale.  Full scale is 255 for 8 bit monochrome
and 24 bit RGB images, and 4,095 for 12 bit monochrome and 36 bit RGB images.

For example, using the Stretch Bright and Dark Level(RGB) option for a 24 bit RGB
image with a range of brightness values between 50 and 150 has the following effects:

§ The lowest value pixels (i.e, 50) are stretched down to 0.

§ The highest value pixels (i.e, 150) are stretched up to 255.
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This one step process provides a quick and easy way to increase image contrast for low
contrast specimens.  To use the Stretch Bright and Dark Level (RGB) option, select
Adjust RGB, Stretch Bright and Dark Level from the Edit menu.  The picture
automatically adjusts itself.

Stretch Bright and Dark Level (HSL)

Like the Stretch Bright and Dark Level (RGB) option, the Stretch Bright and Dark Level
(HSL) option stretches the darkest luminance level in an image to 0 (black) and the
brightest luminance level to 100 (white).  Unlike the RGB mode stretch, however, the
HSL stretch works only on the luminance value, and therefore maintains the original hue
and saturation of an image.  As with the contrast and gamma adjust options using the
HSL color space to stretch images reduces the potential for washed out images and color
shifts.

To use the Stretch Bright and Dark Level (HSL) option, select Adjust HSL, Stretch
Bright and Dark Level from the Edit menu.  The picture automatically adjusts itself.

Adjust Histogram (RGB)

A histogram is a graphical representation of the number of pixels at each brightness level
in an image.  Our RGB histogram displays the red, green, and blue histograms on the
same graph.  The SPOT program's RGB histogram serves two main purposes:

§ It is a point of reference for examining the distribution of brightness levels for the red,
green, and blue components in an image.

§ It can be used to reset the zero and full scale points for an image.  This is known as
stretching.  Like the aforementioned Stretch Bright and Dark Level function, the
Adjust Histogram option enables you to stretch the darker areas of your image to pure
black and at the same time lighten the brighter areas of the image.

! Note: Full scale for 8 bit monochrome and 24 bit RGB images is 255.  Full scale
for 12 bit monochrome and 36 bit RGB images is 4,095.
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To use the Adjust Histogram option, follow these steps:

1. From the Edit menu, select Adjust RGB, Adjust Histogram.  The RGB Histogram
window appears:

2. Set the display parameters for the histogram:

− Determine the color or colors that you want to display brightness values for.  As a
default, the histogram displays all three values.  To display a different
combination of colors, deselect the Show box for the unwanted color(s).

− To display the histogram according to a logarithmic scale, as opposed to a linear
scale (shown above), check the Log Scale box.  Checking the Log Scale box
makes the vertical axis more sensitive to small numbers and compresses the range
for larger numbers, as shown below:
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From the RGB Histogram screen you have three viewing/editing options, each of which
is described below:

§ Examine the number of pixels at each brightness level.
Do one of the following:

− Move the cursor along the graph to display the number of pixels with red, green,
and blue values at each brightness level.

− Type the same brightness level into both boxes under Number of Pixels.  The
histogram readouts display the number of pixels with red, green, and blue values
at that brightness level.

§ Examine the number of pixels between two brightness levels.
Do one of the following:

− Position the cursor over one brightness level on the graph, left click and drag the
cursor to the second brightness level, and release the left mouse button.  The
histogram readouts display the number of pixels with red, green, and blue values
between the two brightness levels.

− Type the two brightness levels into the boxes under Number of Pixels.  The
histogram readouts display the number of pixels with red, green, and blue values
between the two brightness levels.

§ Stretch the image.
Follow these steps:

a) Drag the left triangle (on the X axis) to the brightness level that you want to define
as zero.  All red, green, and blue values that are less than or equal to this level are
now reset to zero.

b) Drag the right triangle (on the X axis) to the brightness level that you want to
define as full scale. All red, green, and blue values that are greater than or equal to
this level are now reset to full scale.

c) The program automatically multiplies all red, green, and blue values between the
new zero point and full scale values by the factor necessary to make the new full
scale setting equal to actual full scale after the new zero point setting (if you have
defined one) has been subtracted.  The thumbnail sample image updates
automatically so you can gauge the effect of your adjustments.

d) Click on OK to save the image with the new zero point and full scale values.

Or…

a) Type the brightness value that you want to define as zero into the Bottom box
under Pixel Values. All red, green, and blue values that are less than or equal to
this level are now reset to zero.

b) Type the brightness value that you want to define as full scale into the Top box
under Pixel Values. All red, green, and blue values that are greater than or equal to
this level are now reset to full scale.
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c) The program automatically multiplies all red, green, and blue values between the
new Bottom and Top values by the factor necessary to make the new full scale
setting equal to actual full scale after the new Bottom value (if you have defined
one) has been subtracted.  The thumbnail sample image updates automatically so
you can gauge the effect of your adjustments.

d) Click on OK to save the image with the new Bottom (zero point) and Top (full
scale) values.

Adjust Histogram (HSL)

A histogram is a graphical representation of the number of pixels at each brightness level
in an image.  Our HSL histogram displays the number of pixels at each luminance level.
The SPOT program's HSL histogram serves two main purposes:

§ It is a point of reference for examining the distribution of luminance levels in an
image.

§ It can be used to reset the zero and 100 % luminance points in an image.  This is
known as stretching.  Like the aforementioned Stretch Bright and Dark Level
function, the Adjust Histogram (HSL) option enables you to stretch the darker areas
of your image to pure black and lighten the brighter areas to pure white (100 %
luminance).

To use the Adjust Histogram (HSL) option, follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Histogram.  The Luminance
Histogram window appears:
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2. If you want to display the image's histogram according to a logarithmic scale, check
the Log Scale box.  Checking the Log Scale box makes the vertical axis more
sensitive to small numbers and compresses the range for larger numbers, as shown
below:

From the Luminance Histogram window you have three viewing/editing options, each of
which is described below:

§ Examine the number of pixels at each luminance level.
Do one of the following:

− Move the cursor along the graph to display the number of pixels at each
luminance level.

− Type the same luminance level into both boxes under Number of Pixels.  The
histogram readouts display the number of pixels at that luminance level.

§ Examine the number of pixels between two brightness levels.
Do one of the following:

− Position the cursor over one luminance level on the graph, left click and drag the
cursor to the second luminance level, and release the left mouse button.  The
histogram readouts display the number of pixels between the two luminance
levels.

− Type the two luminance levels into the boxes under Number of Pixels.  The
histogram readouts display the number of pixels between the two luminance
levels.
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§ Stretch the image.
Follow these steps:

a) Drag the left triangle (on the X axis) to the luminance level that you want to define
as black (0 % luminance).  All red, green, and blue values that are less than or
equal to this level are now reset to black (0 % luminance).

b) Drag the right triangle (on the X axis) to the luminance level that you want to
define as white (100 % luminance).  All luminance values that are greater than or
equal to this level are now reset to white (100 % luminance).

c) The program automatically multiplies all luminance values between the new black
and white values by the factor necessary to make the new white value equal to
100 % luminance after the new black value (if you have defined one) has been
subtracted.  The thumbnail sample image updates automatically so you can gauge
the effect of your adjustments.

d) Click on OK to save the image with the new black and white luminance values.

Or…

a) Type the luminance value that you want to define as black (0 % luminance) into
the Bottom box under Luminance. All luminance values that are less than or equal
to this level are now reset to black (0 % luminance).

b) Type the luminance value that you want to define as white (100 % luminance) into
the Top box under Luminance. All luminance values that are greater than or equal
to this level are now reset to white (100 % luminance).

c) The program automatically multiplies all luminance values between the new
Bottom and Top values by the factor necessary to make the new white value equal
to 100 % luminance after the new Bottom value (if you have defined one) has been
subtracted.  The thumbnail sample image updates automatically so you can gauge
the effect of your adjustments.

d) Click on OK to save the image with the new black (0 % luminance) and white
(100 % luminance) values.

Make Negative

Use the make negative option to make a color negative (with complimentary colors) of an
image.

From the Edit menu, select the Make Negative option.  The program automatically
converts the image to a negative, replacing the original.
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Convert to Gray Scale

Use the Convert Gray Scale option to convert images from color to gray scale.  The
Convert to Gray Scale option works only with color (24 bit and 36 bit) images.

From the Edit menu, select the Convert to Gray Scale option.  The program automatically
converts the color image to a gray scale image, replacing the original.

Sharpen

Use the Sharpen option to sharpen the appearance of soft or blurry looking pictures.  The
Sharpen option works by darkening the darker side of a contrast boundary and
brightening the brighter side of a contrast boundary.

To sharpen the appearance of an image, follow these steps:

1. From the Edit menu, select Sharpen.  The following window appears:

2. Either use the slider bar to select a Strength value between one and 100, or enter the
value in the box.  The Strength value is set as a default to 0, the value used to
represent an unmodified image.  On the opposite end of the scale, a value of 100
represents an image that has been sharpened to the maximum extent.  The thumbnail
preview changes as you adjust the value.

3. When you have determined a suitable value, click on OK.  The sharpened image
replaces the original.

Smooth

Use the Smooth option to smooth out grainy images.  The smoothing option represents
the opposite of the Sharpen function: using the Smooth option lightens the darker side of
contrast boundaries.  Because the Smooth option removes the high frequency details from
an image, some fine image detail is also lost.
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To smooth the appearance of an image, follow these steps:

1. From the Edit menu, select Smooth.  The following window appears:

2. Either use the slider bar to select a Strength value between one and 100, or enter the
value in the box.  The Strength value is set as a default to 0, the value used to
represent an unmodified image.  On the opposite end of the scale, a value of 100
represents an image that has been smoothed to the maximum extent.  The thumbnail
preview changes as you adjust the value.

3. When you have determined a suitable value, click on OK.  The sharpened image
replaces the original.

Filter Noise

Use the Filter Noise option to correct for the effects of electrical or thermal noise.  The
Filter Noise option eliminates single, isolated pixels that appear out of place due to
electrical or thermal noise by checking each pixel on the CCD chip three times
(corresponding to the red, green, and blue filters).  If the brightness value for a pixel
differs from all of the eight surrounding pixels by more than the percentage value that
you specify, it is replaced with the average value of the surrounding eight pixels.  This
option works well with dim images.

To use the Filter Noise option, follow these steps:

1. From the Edit menu, select the Filter Noise option.  The following window appears:

2. Enter a value between 10 % and 100 %.  The Threshold value, which is set to a
default of 50 %, indicates the percentage by which a pixel is allowed to differ from
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the eight pixels that surround it.  If a pixel differs from all of the eight surrounding
pixels by more than the value that you specify, the program treats it as noise and
replaces the original brightness value with the average value of the eight surrounding
pixels.

3. Click on OK.  The filtered image appears on-screen, replacing the original.

! Note: Image setups can be defined to automatically use the noise filter when
capturing an image.  Refer to Chapter 3, Preparing to Take a Picture for details.

Customizing Images

In addition to the image editing features described in this chapter, the SPOT software
offers several options that allow you to customize images.  They are as follows:

§ Combine Images – This option allows you to add an image to or subtract an image
from a selected open image.  This option allows researchers using double and triple
stained fluorescence techniques to excite one dye at a time, capture a color image of
each excitation, and then add the individual images together to create a composite
image that illustrates excitation of all the dyes.

§ Change Pixel Bit Depth – This option allows you to change from one bit depth to
any of the other three options without having to recapture an image.

§ Merge Images – This option allows you to merge two or three images, assigning red,
green, or blue to each image.  The Merge Images feature is primarily used to combine
two or three monochrome images into an artificially colored composite image.

§ Annotate – The Annotate option provides you with a powerful and easy to use set of
image annotation options.

All of the preceding options are discussed in the sections that follow.

Combine Images

Use the Combine Images option to add and image to or subtract an image from a selected
open image.

To use the Combine Images option to add an image to a selected open image, follow
these steps:
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1. From the Edit menu, select Combine Images and Add Image.  The Add Image
window appears:

2. Select the Source of the image that you want to add to the currently open, selected
image.  The image can come from one of the following three sources:

− A Currently Open Image – Select Currently Open Image to add an open image
to the currently open, selected image.  The Title Scroll Bar displays all of the
images that are open, including the selected image.  Thus, it is possible to add an
image to itself.

− An Image File – Select Image File to add a file from disk to the currently open,
selected image.  Either enter the file path in the box, or click on the browse button
to the right of the box to search for and select a file from disk.

− A Database – Select Database to add a file from a SPOT database to the currently
open, selected image.  To add an image from a SPOT database you must enter the
Image ID for that image.  You can determine the eight digit Image ID number by
searching the database for the image that you want to add.  The search results
display the image ID number.

! Note: To Add or subtract a database file, the database must be open.  For more
information on using SPOT databases, refer to Chapter 7, Using SPOT
Databases.

3. Click on OK to add the image.  The combined image replaces the original.
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To use the Combine Images option to subtract an image from a selected open image,
follow these steps:

1. From the Edit menu, select Combine Images and Subtract Image.  The Subtract
Image window appears:

2. Select the Source of the image that you want to subtract from the currently open,
selected image.  The image can come from one of the following three sources:

− A Currently Open Image – Select Currently Open Image to subtract an open
image from the currently open, selected image.  The Title Scroll Bar displays all
of the images that are open, including the selected image.  Thus, it is possible to
subtract an image from itself.

− An Image File – Select Image File to subtract a file from disk from the currently
open, selected image.  Either enter the file path in the box, or click on the browse
button to the right of the box to search for and select a file from disk.

− A Database – Select Database to subtract a SPOT database image from the
currently open, selected image.  To add an image from a SPOT database you must
enter the Image ID for that image.  You can determine the eight digit Image ID
number by searching the database for the image that you want to add.  The search
results display the image ID number.

! Note: To Add or subtract a database file, the database must be open.  For more
information on using SPOT databases, refer to Chapter 7, Using SPOT
Databases.

3. Click on OK to subtract the image.  The modified image replaces the original.
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Change Pixel Bit Depth

Use the Change Pixel Bit Depth option to change the bit depth of the currently open
image without going through the entire image capture process.

To change the pixel bit depth for an image, follow these steps:

1. From the Edit menu, select the Change Pixel Bit Depth option.  The Change Pixel Bit
Depth window displays the current Pixel Bit Depth for image, as shown here:

2. Select the pixel bit depth that you want to change the image to.  Consider the
following situations:

− Changing from one monochrome bit depth to another (i.e., 8 bit to 12 bit) or from
one RGB bit depth to another (24 bit to 36 bit) does not require the addition of
any color channeling information.  In this case, select the new pixel bit depth and
click on OK.

CAUTION!
If you are changing an image to either 12 bit or 36 bit pixel bit depth, you must save the
image in TIF format before you can close it.  Refer to step four for further instructions.

− Changing from an RGB (24 bit or 36 bit) image to a monochrome image (8 bit or
12 bit), requires the entry of color channeling information.  In this case, when you
select the new pixel bit depth, the color channeling information appears on the
Change Pixel Bit Depth window, as shown here:
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Select the color channel(s) that you want to use.  Select either a single color or the
All Channels option, which is the default.

CAUTION!
If you are changing an image to either 12 bit or 36 bit pixel bit depth, you must save the
image in TIF format before you can close it.  Refer to step four for further instructions.

3. Click on OK to save the image with the new pixel bit depth.

4. If you changed the original pixel bit depth to either 12 bit or 36 bit, follow these steps
before trying to save the image to disk:

a) From the SPOT File menu, select the Save As option.  The Save As window
appears.  The Save as type dialog box should contain Tiff Uncomp (tif).  This is
the only file type option available when changing to 12 bit or 36 bit.

b) Enter the desired file name and location, and click on the Save button.  The
following dialog box appears:

! Note: If you changed your image to a 12 bit pixel bit depth, the File Bit Depth box
prompts you to save it either as 12 bpp or 16 bpp.  If you changed your image to
a 36 bit pixel bit depth, the File Bit Depth box prompts you to save it either as
36 bpp or 48 bpp.  The additional choices enable you to create versions of your
images for use in other applications such as PhotoShop.

c) Select the Bits per Pixel that you want to save the image to.

d) Click on OK.  The image is now saved as a TIF file.

Merge Images

Use the Merge Images option to merge two or three images into one image.  As noted,
the Merge Images feature is primarily used to merge two or three monochrome images
into an artificially colored composite image.  Unlike the Combine Images feature, which
adds to the pixel values of an image, the Merge Feature adds only the red, green, or blue
values that correspond to the color which is assigned to the image (when merging RGB
images).  In addition, the merge image process creates an entirely new file, as opposed to
replacing the original file, as is the case with the Combine Images option.
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To use the Merge Images feature, follow these steps:
1. From the Edit menu, select the Merge Images option.  The following window

appears:

2. Select the color channel or channels that you want to use for the merge.  Selecting the
color channel(s) activates (un-grays) the image source selection options.

3. For each color channel, select the source of the image that you want to merge into the
new image.  The source can be:

− A Currently Open Image – Select Currently Open Image to merge a currently
open image.

− An Image File – Select Image File to merge a file from disk, or click on the
browse button to the right of the box to search for and select a file from disk.

− A Database – Select Database to merge a SPOT database image.  To merge a
database image you must enter the Image ID for that image.  You can determine
the eight digit Image ID number by searching the database for the image that you
want to add.  The search results display the image ID number.
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! Note: To Add or subtract a database file, the database must be open.  For more
information on using SPOT databases, refer to Chapter 7, Using SPOT
Databases.

3. Click on OK to create the merged image.  The new (merged) image appears on-
screen.

4. Save the merged image.

Annotate

The Annotate editing options enable you to annotate existing images.  Annotation of
images is particularly useful when you want to prepare image captures for formal
presentation, or inclusion in an article or reference work.  For example, using the image
annotation features, you can:

§ Add textual annotation to an image.

§ Use an arrow, line, rectangle, or ellipse to emphasize a particular area in an image.

§ Add a graphic/textual stamp to an image.

§ Add freehand annotation to an image.

When you select the Annotate option on the Edit menu, three changes take place in the
SPOT image editing environment:

§ The image capture toolbar buttons are replaced with nine annotation toolbar buttons.

§ The Edit menu options change to reflect annotation editing, as opposed to the image
editing discussed earlier in this chapter.

§ The View and Camera menus disappear, and three new menus appear at the top of the
screen:

− The Object menu options parallel the nine annotation toolbars.

− The Attributes menu enables you to control the qualities of the annotations.

− The Done! menu allows you to switch back to the image capture/edit mode.
When you select Done! after you have annotated an image, the SPOT program
prompts you to merge the changes into the image.

CAUTION!
If you select Yes after clicking on Done! the annotations become a permanent part of the
image.  Use the Save As feature to save the annotated version of the image to a different
file.

Each of the above aspects of image annotation in the SPOT program is discussed in the
sections that follow.
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Annotation Toolbar Buttons/Object Menu

When you select the Annotate option from the Edit menu, the image capture Toolbar
buttons are replaced with nine image annotation buttons.  These Toolbar buttons are also
available as Object menu options.  All operations are activated either by clicking the
desired Toolbar button or selecting the corresponding Object menu option.

The following table illustrates each annotation Toolbar button and describes its function:

Select – Select the annotation that you have added to the image.  Click on an
annotation to select it.  When you select an annotation, you can resize it by left clicking
and dragging the appropriate handle.

Freehand – Add a freehand annotation to the image.  Left click on the area in which
you want to insert the freehand drawing, and drag until completed.

Straight Line – Add a straight line annotation to the image. Left click on the area in
which you want to insert the line, and drag until completed.

Arrow – Add an arrow to the image. Left click where you want the arrow to point, and
drag away from the area that the arrow will point to.  To change the size and/or style of
the arrow point, select the arrow and double click on it.  An arrow attributes window
appears.
Rectangle – Add a rectangular annotation to the image.  Left click at the point where
you want to insert the rectangle and drag until the rectangle is complete.

Ellipse – Add an elliptical annotation to the image. Left click at the point where you
want to insert the ellipse and drag until the shape is complete.

Polygon – Add a multi – sided figure to the image.  To create the sides of the polygon,
left click at the point where you want to end each line.

Stamp – Insert a selected bitmap image onto the image.  To select the bitmap image
that you want to insert, choose the Stamp Bitmap option from the Attributes menu.

Text – Insert textual annotation into a selected area.  Left click and drag to determine
the size of the area in which you will insert the text annotation.  The cursor then
prompts you to enter the text.
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The Attributes Menu

The Attributes menu options allow you to:

§ Set a standard appearance for the annotations that you plan to add.

§ Modify existing annotations.  To modify the attributes of existing annotation, select
the annotation (i.e., with the Select Toolbar button), and then adjust the attributes.

The following table describes each of the annotation attributes:

Attribute Description

Foreground Color Color of the line, object, or text.  There are seven colors to choose from.

Background Color Background color for objects.  In order to set a background color, the Mode
attribute (see below) must be set to Opaque.

Line Thickness Thickness of the line for lines, arrows, and objects (i.e., the border of a
rectangle).  A thickness of 1 is the thinnest line possible, while 4 is the
thickest line possible.

Line Style The appearance (i.e., solid, dashed, etc…) of the line for lines, arrows, and
freehand objects.  In order to use the Line Style attribute, you must set the
Line Thickness to 1.

Pattern The pattern for inserted objects such as rectangles, ellipses, polygons, and
text boxes.  There are seven pattern options to choose from.

Mode The background type for inserted objects such as rectangles, ellipses,
polygons, and text boxes.  There are three modes to suit varying image
types: transparent, opaque, and tinted.

Text Font The font, style, and size of the text.  When you select the Text Font
attribute, the standard Windows Font selection window appears.

Stamp Bitmap The bitmap used with the Stamp option.  When you select the Stamp
Bitmap attribute, the Choose Stamp Bitmap window appears.  This window
allows you to select the bitmap image that you want to be the default for
use with the Stamp option.

Edit Options

As noted earlier, the Edit menu changes to work with in accordance with the annotation
functions.  You can access the annotation editing options in two ways:

§ By selecting an option from the Edit menu.

§ By selecting and then right clicking on the annotation.

You can also move an annotation by left clicking on it and then dragging the item to a
new location.  When you drag the item, the cursor becomes a four pointed arrow.

In order to perform any of the above editing functions (with the exception of the Undo
and Delete All options), you must select the annotation.



Ch. 5 - Viewing, Editing, and Annotating Images Edit - Customizing Images

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 102

The following is a list of the annotation editing functions.

§ Undo – Undo the last action.  Unlike the image capture/editing Undo feature, the
annotation Undo undoes an unlimited number of changes.

§ Bring to Front – Bring the selected object in front of another object.

§ Send to Back – Send the selected object behind another object.

§ Cut – Remove the selected item.

§ Copy – Duplicate the selected item.

§ Paste – Place the cut or copied item into the image, where it can be moved to the
desired location.

§ Delete – Delete the selected annotation.

§ Delete All – Delete all of the annotations.
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Introduction
The SPOT software provides you with the means to calibrate the objectives on your
microscope.  You can then use the calibrated objectives to perform different
measurements on an image.  Both the Calibration and the Measurement functions are
performed through the Show Measurements option on the View menu.

Calibration

Before using the SPOT software to perform measurements on images, you should
calibrate each of the microscope's objectives using a stage micrometer.  To calibrate an
objective, follow these steps:

1. Place the stage micrometer in the objective's field of view.

2. Focus on it.

3. Capture an image of the stage micrometer.

! Note: For details on capturing an image, refer to Chapter 4, Taking a Picture.

4. From the View menu, select the Show Measurements option (or press [Ctrl M]).  The
Measurement window appears, as shown below:

5. The Calibration Setup box should be blank.  To calibrate the objective that you are
using, click on the Add button.

− To modify an existing Calibration Setup, click on the Modify button.
− To delete an existing Calibration Setup, click on the Delete button.
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The Calibration Setup window appears, as shown below:

6. Enter a name for the Calibration Setup (i.e., 50x).

7. With the Calibration Setup window open, use the mouse to draw a line along the
length of the stage micrometer image.

a. Position the cursor on the image (of the stage micrometer).

b. Left click on the mouse.  The drawing function is now enabled.  Drag the mouse
across the image of the stage micrometer.

c. Left click at the point where you want to end the line.

d. Click on the Calibration Setup screen to re-activate it.  The Calibrate button
should now be active.

8. In the lower boxes, enter the length of the line in whatever units you are calibrating
to, as illustrated below.  In this example, the 50x objective has been set to calibrate
the number of pixels for the 5 micron line that you drew:
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9. Click on the Calibrate button.  The number of pixels per 5 microns appears.

10. Click on OK. Repeat steps 1 - 9 for each objective.

Measurement

Once you have specified the calibration for an objective, you can then use the SPOT
software to perform different types of measurements on an image.

To perform a measurement on an image, follow these steps:

1. From the View menu, select the Show Measurements option (or press [Ctrl M]).  The
Measurement window appears, as shown below:

2. Select a Calibration Setup from the list.  Typically, the Calibration Setups correspond
to your microscope’s objectives.

3. Select from one of four measurement options:
− Straight line
− Curve
− Angle
− Region Area

! Note:  Angle measurements are independent of the Calibration Setup.

4. Draw the line, curve, angle or area that you want to measure.
a. Position the cursor on the image that you are measuring.

b. Left click on the mouse.  The drawing function is now enabled.  Drag the mouse
across the image to perform the measurement.

c. Left click at the point where you want to end the measurement.

d. The length, number of degrees, or square units appears at the bottom of the
window.
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Introduction
In addition to the numerous image capture and editing features, the SPOT software
provides you with a database that you can use to archive images.  In the SPOT program,
the term database refers to an umbrella structure used to organize the actual databases,
which are known as image categories.

This Chapter is divided into three larger sections:

§ The Database Menu

§ Creating and Modifying Databases

§ Searching Databases

! Note: The SPOT database is structured as an umbrella so that you can password
protect all of your image categories as a group, as opposed to having to enter and
keep track of separate passwords for each image category .

The Database Menu

The Database menu options remain inactive (gray) until you open a database.  When a
database is open, you have the following options:

§ Open – The Open option turns on the database engine and allows you to create,
modify, or search the image category databases.  When you select the Open option,
the Open Database window appears.  From this point, you can:

− Create a new database.

− Open an existing database.

− Delete an existing database.

! Note: Only one database can be opened per session.  If you try to open a second
database, the program prompts you to close the open database.

§ Close – The Close option turns off the database engine and deactivates all database
functionality.

§ Change Password – The Change Password option enables you to:

− Determine whether a password is required to access your image categories.

− Define an alphanumeric password.
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§ Lookup Lists – Use the Lookup Lists option to:

− Create and name new lookup fields for an image category in the open database.
Once you have created a lookup field, you can then associate a list of choices with
the lookup field.

− Add, modify, or delete lookup list items.

§ Image Categories – Use the Image Categories option to create, modify, or delete
image categories (i.e., your databases).

§ Image File Locations – Use the Image File Locations option to specify the file path
for the database (i.e., C:\images\database).

§ Search – Use the Search option to search the open image category.

§ Edit Image Record – This option, which only appears on the menu when a database
image is open, enables you to edit the search criteria, date, time, and memo associated
with the image.

! Note:  The Lookup Lists, Image Categories, Image File Locations, Search, and Edit
Image Record options are discussed in more detail in the next two sections,
Creating and Modifying Databases and Searching Databases.

Creating and Modifying Databases

The following sections outline the steps involved in creating and/or modifying SPOT
databases.  To best understand how a SPOT database works, this section takes you
through all of the steps involved in creating a typical database. All of the sample entries
are based on a fictitious scenario:

§ You are a biological researcher at a university, and your lab is equipped with a
microscope, a SPOT camera, and a computer.

§ Your work involves both blood and hair samples.

§ To publish the results of your research, you will need to search through thousands of
images accumulated over the course of your research for samples that meet specific
criteria.

We recommend that you enter in the sample information as you read through the text.

Creating a new database consists of the following steps:

§ Defining the Database (i.e., the umbrella structure that “houses” your image
categories).

§ Setting Up Image Categories (i.e., the databases that contain your images).
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§ Defining Lookup Lists

§ Saving Images to the Database

Each of these steps is discussed in the sections that follow.

Defining the Database

The first step in creating a database is to define the umbrella structure that houses the
image categories which contain your images.  To define the database, follow these steps:

1. From the Database menu, select the Open option.  The Open Database window
appears, as shown below:

2. Click on the New button.  The New Local Database window appears, as shown here:
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3. Enter [YOUR NAME] in the Name box.

4. Specify the location of the database by typing in the file path in the File box, or using
the button to the right of the box to browse for a location.

The [YOUR NAME] database file will contain all of the information associated with
your images, including the image ID number, the search criteria, and the path to
where the image is stored.  It does not contain the actual image.

5. To set up a password for the database, check the Require Password option, and enter
1 – 10 alphanumeric characters in the Password box.  Re-enter the password in the
Enter Again box.

6. Click on OK to create the database, or click on Cancel to return to the Open Database
window.

Setting Up Image Categories

Once you have defined the database, you can begin setting up the image categories.  To
create a new image category, follow these steps:

1. From the Database menu, select the Image Categories option.  The following window
appears:
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2. The database that you defined in the previous section (i.e., Shuman in the example)
should appear at the bottom of the screen.  To add an image category to this database,
click on the Add button.  The Image Category window appears:

3. Enter Blood in the Category Name box.

Since you are working with blood and hair samples, each of which are judged by
different criteria, they should each be defined as a separate image category.

Data Fields

After naming the image category, you have to define the associated data fields.  There are
two types of data fields:

§ Text/Numeric – Text/Numeric data fields are the fields that will be available to enter
information in when you save an image to an image category.  When you enter
information into a box, the program automatically determines whether it is a textual
or numeric field, and checks the appropriate option.

There are some occasions where you might want to change the text or numeric
setting.  For example, the program performs text field searches by looking for textual
strings, while it performs numeric field searches by looking for a range of values.
Thus, if you have information such as a patient ID number, you would want to define
it as a Text field because it is not a measurement or within a specific range of values.



Ch. 7 - Using SPOT Databases Creating and Modifying Databases

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 113

§ Lookup – Lookup data fields are also available when you save an image to an image
category.  Each lookup field can also be associated with a list, through the Lookup
Lists option on the Database menu.

Lookup fields enable you to select an image quality from a pre-defined list, rather
than having to type it in each time.

CAUTION!
After you have named the data fields for an image category, you cannot change the Text
or Numeric setting.  Although you can make changes to an existing field name (i.e., to
correct a spelling error or make a more intuitive name), you should not change the
meaning of the field.  This will render the field useless for searches performed on all
previously stored images.

There are two options associated with the Data Fields.  They are as follows:

§ Required – Checking this option forces the user to enter data for the text field when
saving an image.

§ Title – Checking this option ensures that the data from the text field will appear in the
title of the image window and under any thumbnail of the image.

Enter the Data Fields as described in the following steps:

1. Enter Patient’s Name in the first Text/Numeric field, and check the Required and
Title boxes.

2. Enter Blood Oxgen Level in the second Text/Numeric field.  Because Blood Oxygen
Level represents a value on which you will want to perform searches based on a range
of values, you should select the Numeric option.

3. Enter Blood Color in the first Lookup field.

4. Enter Research Assistant in the second Lookup field.

! Note:  The Image Category window allows you to enter only the list titles (i.e., the
Lookup fields)  To enter the items associated with the Lookup (i.e., the different
blood colors), you must either  use the Lookup Lists option or add the items when
you save an image.  For more details on this process, refer to the next section,
Defining Lookup Fields and Lists.

Default Settings

To complete the process of defining an image category you must also enter the default
settings.  The default settings are the settings that will appear every time that you save an
image to an image category.

! Note:  The default settings can also be changed from the Save Image to Database
window, which appears when you use the Save to Database File menu option.
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The Default Settings include the following:

§ Image Path – The path to the folder where the database will store the images in this
category.  The folder can be stored on a hard disk, a network drive, a JAZ drive, or
even a CD-R (a recordable CD).

CAUTION!
Because each database image file will between 1.3 Mb and 8 Mb in size (uncompressed),
there are limitations on the number of files that you can store.  These limitations vary
according to your operating system and the storage medium.  You should carefully plan
out how you will organize and store your current images, as well as how you plan to
accommodate future images.  For more information on storage planning, contact your MIS
department or a qualified computer or network specialist.

§ Field Entries – The Field Entries setting enables you to specify default entries for
text, numeric, or lookup fields.  For instance, if you are performing 25 tests on a
blood sample for a single user, whose blood color is red, you could specify that red
should appear in the Blood Color field and that the patient’s name should appear in
the Patient Name field for all of the images that you save to the image category.

§ Format – The graphic format that you want to save the image to the database (image
category) with.

1. Windows Bitmap 5. Mac Pict 9. Sun Raster 13. Tiff Jpeg
2. Windows

Clipboard
6. Paintbrush 10. SGI Image 14. Tiff Packed

3. IFF 7. PNG 11. Truevision Targa 15. X-PixMap
4. Jpeg 8. Adobe Photoshop 12. Tiff Uncomp 16. X-Windows

Dump

§ Save Thumbnails – This option, if checked, saves a thumbnail image of each image
in the database so that you can quickly browse through all the images in a category.

For the Blood image category, set the defaults as follows:

1. For the Image Path (folder), enter C:\Spotcam\blood.

2. Skip the Field Entries option.

3. For the Format, select the Windows Bitmap option.  This option saves the images to
the database in a high quality, uncompressed format.

4. Ensure that the Save Thumbnails box is checked.
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When you finish entering the defaults the screen should appear as follows:

Defining Lookup Lists

After you have created an image category and defined the Lookup Fields, you should
create the List of items that is associated with each Lookup Field.  This can be done in
one of two ways:

§ You can enter list items through the Lookup Lists option on the Database menu.  This
is the primary method.

§ You can enter list items as you save an image to a database (image category).  This
method is used when you want to save an image, but the criteria for that particular
image has not yet been defined.

! Note:  The procedure for adding lookup list items to lookup fields while saving
images to a database is discussed in the Saving Images to the Database section.
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To enter list items with the Lookup Lists option, follow these steps:

1. From the Database menu, select the Lookup Lists option.  The following window
appears:

The Lookup Fields that you defined on the Image Category window should appear,
along with the name of the umbrella database (i.e., shuman).  From the Lookup Lists
window, you can add new Lookup Fields as well as the associated lists.  In this
example, you will add the list items for the lookup fields that you created for the
Blood image category.

2. Select the Blood Color lookup.  The Modify and Delete buttons should now be active.

3. Click on the Modify button.  The Field Lookup window appears, as shown here:
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4. Click on the Add button.  The Lookup Item dialog box appears, as shown here:

5. Enter red in the Item box, and click on OK.

6. Repeat steps four and five to add the green and blue to the Blood Color lookup list.

7. Click on OK to save the list items and return to the Lookup Lists window.

8. Select the Research Assistant lookup list, and follow the procedure in steps two
through five to add the names of three research assistants: Jason, Karen, and Bill.

9. Click on Close to save your changes and close the Lookup Lists window.

Saving Images to the Database

Once you have acquired the images that you want to store in your database, the SPOT
program makes it easy to save the information.

To save an image to your newly created database, follow these steps:

1. From the File menu, select the Save to Database option.  The Save Image to Database
window appears as follows:
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The program automatically displays the date and time that you saved the image.  This
information can be modified as needed.

! Note: When you save an image to a SPOT database, the program automatically
creates an eight digit image ID that is stored in the image path folder.  This is a
reference number that the program uses to access images and associated data.

2. Select the Image Category that you want to save the image to.  Because you only
defined one image category (i.e., Blood), that is the only available option.

3. Enter John Smith in the Patient’s Name box.  Note that T appears next to this box,
indicating that the field has been defined as a text data field.

4. Enter 4.7 in the Blood Oxygen Level box.  Note that N appears next to this box,
indicating that the field has been defined as a numeric data field.

5. Select green from the Blood Color list.

6. Select Karen from the Research Assistant list.

! Note: If your define a data field as required (i.e., on the Image Category window),
you will not be able to close the window without entering the inforation.

7. Keep the default settings that you defined on the Image Category screen:

− Image Path (folder) - C:\SPOTCAM\blood

− Format – Windows Bitmap

− The Save Thumbnail option is checked.

The program automatically displays this information when you save an image; you
should not have to enter anything if you want to retain the default settings.

8. Click on the Memo button.  The Image Memo window appears.  Enter the following
message:  Ancestry of the patient was difficult to determine.

9. Click on OK to save the message and close the Image Memo window.

At this point, you decide that you want to change the blood color to purple.  You also
realize that it was Clare, not Karen, who was the research assistant that took this sample.
The SPOT software enables you to add these new list items while saving the image.

Do the following:

10. In the Blood Color box, enter purple.

11. In the Research Assistant box, enter Clare.
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12. Click on OK to close the window and save the image to your database.  The
following window appears:

13. Click on Yes to add purple to your Blood Color lookup list.

14. The program prompts you to add Clare to the Research Assistant list.  Click on Yes.
The program adds the new items to the Lookup Lists, and closes the Save Image to
Database window.

! Note:  The Time, Date, Memo, and data field entries for saved images can be edited
at a later point through the Edit Image option on the Database Menu.

Searching Databases

The SPOT database search function enables you to search an image category in an open
database.  To perform a search follow these steps:

1. From the Database menu, select the Search option.  The Search Image Database
window appears as shown below:
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2. Select the Image Category that you want to search.  All of the Image Categories that
you defined for the open database are available.

3. Enter the Image Dates.

− If you enter both a begin and an end date, the program searches for images with
save dates either on or between the two dates.

− If you enter a begin date only, the program searches for images with save dates
greater than or equal to your entry.

− If you enter an end date only, the program searches for images with save dates
less than or equal to your entry.

− If you do not enter any Image Dates, the program searches for images with any
save date.

4. Enter the search criteria for the data fields.  In the above screen capture, for example,
the data fields are denoted as follows:

− Text fields (i.e., Title and Stain) are denoted with a T.

− Numeric fields (i.e., Diameter and Tech I.D.) are denoted with an N.

− Lookup fields (i.e., Size, Color, Magnification, and Specimen Type) appear as
select lists, where you can select one, several, all, or none of the lookup list
options.

Use the following guidelines to enter search criteria:

Text searches are limited to images with text strings (i.e., specific letters or numbers
in a row).  Two characters can be used with text field searches:

− * - The asterisk wild card tells the program that any number of characters can be
used with this text field.

For example, if you want to search all patients with “smith” in their name, you can
type *smith* in the Patient’s Name text field.  This search will bring up names
such as John Smith, Jane Smithfield, and Joe Hammersmith.

− ? -  The question mark wild card tells the program that any single character can be
used where the question mark appears.

For example, if you want to search for patients with either the name Smith or
Smyth, you can enter * sm?th in the Patient’s Name text field.  The asterisk and
space in the front of sm?th tells the program to find all first names associated with
sm?th.  The question mark tells the program to search for one letter difference
variations on the name Smith.  This search will bring up names such as John
Smith, Anne Smyth, and Fred Smoth, but it will not bring up Jane Smithfield,
Harry Hammersmith, or Abigail Smythe.
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Numeric searches are restricted by the following logical symbols:

= Selects records equal to the value entered.

<> Selects records not equal to the value
entered.

< Selects records less than the value entered.

> Selects records greater than the value
entered.

<= Selects records less than or equal to the
value entered.

>= Selects records greater than or equal to the
value entered.

AND Selects records that contain both of the
values entered.

OR Selects records that contain either of the
two values entered.

For example, to search for all patients with a blood oxygen level between 3.6 and 7.7,
you would enter >3.6 AND <7.7 in the Blood Oxygen Level numeric field (not
shown here).

Lookup field search criteria are specified by selecting one, several, all, or none of the
lookup list options.  Searches are limited to images that match the item or items.

5. Select the Display Matches as option:
If you check the Table box, the matches are displayed in a table, as shown below:
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The table view displays matches by title in a numbered list that includes the
following:

− The total number of matches

− The search criteria used

− A thumbnail of the image

From the Images table, you can do the following:

− Open an image – To open an image, scroll down the table to the desired image
and left click on the thumbnail.

− Edit a database record – To edit the search criteria and/or memo for a record,
either select the record and click on the Edit button, or double click on the record.
The Image Database Record window appears, as shown here:

The Image Database Record window enables you to edit the characteristics (search
criteria) of an image while in the database, as opposed to during the save process.
Thus, you can correct any mistakes made during the original entry process.

You can also use the buttons at the bottom of the window to access and edit all of
the other images found by the search.  When you finish editing the image(s), click
on OK to return to the table view.

− Delete a record.  To delete a record from the database, select the record and click
on the Delete button.

− Switch to the Thumbnail view.  Click on the Show as Thumbnails button.
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If you select the Thumbnail View the matches are displayed as thumbnail images in
a window, as shown here:

For reference, the thumbnail view window title displays the name of the image
category.  From the thumbnail view, you can:

− Left click on an image to open the image.

− Right click on an image to open the Image Database Record window and edit the
search criteria and memo for the image.

6. To select the order in which you want the search results to be displayed, click on the
Ordering button.  The Record Ordering window appears, as shown here:

The Record Ordering window provides a three level sort order.  The Order by select
lists display the search criteria.  To order the records for a search, do the following:

a. Select the search criteria from the Order by list (i.e., Diameter) for the first level
of sorting.

b. Select either Ascending or Descending.

c. If desired, define the second and third sort levels in the same manner.

d. Click on OK to return to the Search Image Database Window.

7. Click on OK to start the search.  When the program finishes searching, the results
display as you specified them.
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Introduction
The printing features in the SPOT program fall into two categories that correspond to the
two File menu print options:

P Printer Setup - These are the standard Windows dialog boxes that allow you to
specify the printer and its setup, page setup/orientation, and paper size and source.

P Print - The SPOT program provides you with the tools needed to print one or multiple
diagrams on a page.

This chapter provides a brief overview of the standard print setup features and a detailed
discussion of the features that are unique to the SPOT software.

Printer Setup

Printing an image from the SPOT program requires you to choose and configure a
printer.  The procedure for setting up and configuring printer in SPOT is the same as in
any other Windows program.

! Note:  Because the information contained in this section is standard Windows
functionality, the options are not discussed in detail.  For more information on
Windows printing features, refer to the Windows on-line help.  A question mark in
the upper right hand corner of a window indicates that context sensitive help is
available.  Clicking on the question mark changes the cursor to a question mark.
Drag the question mark to the option that you want help with, and click.  A pop-up
window explains the item.

To choose and configure a printer, follow these steps:

1. Choose a printer.  From the File menu, select Printer Setup.  The Page Setup
window appears.  To select the printer you want to use, click on the Printer button at
the bottom of the window.  The following window appears:
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2. View the printer properties, if necessary.

! Note:  The printer properties screen and options will vary in appearance
according to the printer that you are using.

3. Define the page setup that you want to use for the image(s).  This includes the
page orientation (portrait or landscape), paper size, paper source, and margins.  All of
these items are entered from the Page Setup window, shown here:

To save the page layout specifications that you enter, click on OK.

! Note:  You can also access the Page Setup screen from the Print screen (i.e., From
the File menu, select Print, and click on the Setup button.
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Print

After you have defined the printer and page layout, as discussed in the last section, you
are ready to print.  With the SPOT software, you can print a single image to a page or you
can print multiple images on a page for comparison or display.  Each of these options is
discussed in the following two sections:

Printing a Single Image

To print a single image from the SPOT software, follow these steps:

1. From the File menu, select Print.

Shortcuts:  To access the print screen, you can also:

− Press [Ctrl P] (a standard windows shortcut).

− Click on the Print toolbar button:

− 

The Print window appears with a smaller version of the active image:
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The Print window displays the following information:

− Printable Area: The printable dimensions of the page.

− Top Image:  The position and size of the top-most image (if more than one image
will  be printed on the page).  They are:

♦ Left - The distance between the left side of the printable area and the left side
of the image.

♦ Top - The distance between the top of the printable area and the top of the
image.

♦ Width - The width of the image.

♦ Height - The height of the image.

4. Check either Inches or Millimeters to specify the units of measurement.

5. Adjust the size of the image:

a) Position your cursor on a side or a corner of the image.  The cursor turns into a
two-ended arrow.

b) Using the two-ended arrow cursor, drag a side or corner to enlarge or reduce the
image.  The resized image maintains the height to width ratio of the original
image so as to avoid distortion.

6. Adjust the position of the image.

a) Position the cursor on the image.  When on the image, it appears as a four pointed
arrow.

b) Left click and drag the image to the desired location.

7. Click on the Print button.  The Printing dialog box displays the job.

8. To stop the print job, click on the Abort button.

Printing Multiple Images on a Page

For comparison and display purposes, the SPOT camera allows you to print multiple
images on a single page.  The additional images do not need to be open; you can add
additional images from any file directory.

To add and arrange multiple images for printing, follow these steps:

1. From the File menu, select the Print option.  The currently open, selected image
appears in the Print window.
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2. Add an image to the page for printing.  Follow these steps:

a) Click on the Add button.  The Add Image window appears, as shown here:

b) Select the image that you want to add.  An image can be added in one of three
ways:

♦ It can be selected from an open image other than the currently active image
(i.e., the one displayed on-screen).  This option can be very useful if you have
several versions of an image open and want to print out a comparison sheet.

To add an image from a list of open images, click on the Currently Open
Image option and select the desired image.

♦ It can be added from a file directory.

To add an image file from a directory check the Image File option, and click
on the square next to the box.  Browse for the desired image.

♦ It can be added from an open SPOT database.

To add an image file from a SPOT database, you must know its Image ID
number.  After you have determined the number, check the Database option,
and enter the eight digit Image ID.

c) Click on OK.  The program places the newly added image on top of the original
image, covering the original image.

3. To add additional images, repeat step 2.
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4. To arrange how the images will appear on the page, follow these steps:

a) Click on the Arrange button.  The  Arrange Images window appears, as shown
here:

b) Select the number of rows and columns.

c) Enter the Spacing between the images on the print-out in inches or millimeters.

d) Click on OK.  The Print screen reappears with a preview of your print
arrangement.  The following screen capture illustrates two pictures arranged in a
one row, two column format:
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The SPOT program automatically resizes images to fit on the page.  This allows you
to add multiple images without having to worry about resizing them.  For example, if
you add five images, the preview will show six images (the original and five added)
of equal size, distributed equally across the page.

! Note:  You can reposition and resize multiple images on the preview page, just as
you can with a single image.

5. From the print screen, you have several options:

− You can add another image as described in steps three and four.

− You can delete the newly added image by selecting it and clicking the Remove
button.

− You can reposition and/or resize the images as described in the previous section.

6. When you finish adding and arranging the images that you want to display, click on
the Print button to print the images.
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Appendix A: Specifications
Camera SPOT SPOT 2 SPOT Jr.

Catalog Number SP100 SP110-2 SP120

Sliding Color Filter No Yes No

CCD Part Number Kodak KAF - 1400 Kodak KAF - 0400

CCD Resolution/Active
Area

1315 x 1035 pixels/8.98 mm x 7.04 mm 768 x 512 pixels/6.91 mm
x 4.61 mm

Pixel Size 6.8 Fm x 6.8 Fm 9.0 Fm x 9.0 Fm

CCD Grade 3 2 2

Digitization Pixel-by-pixel digitization in the camera head.

CCD Cooling Thermoelectric with forced air.
Cooled to -12E C (37Ebelow ambient at a typical room temperature of 25E C).
Temperature stability of +/- 1E C in an eight hour period.

Color Image Acquisition Three pictures taken - one each in red, green, and blue.  The liquid crystal filter in front of
the CCD chip changes color for each picture, and the software combines the images into
one RGB color image.

Pixel Bit Depth Choices 8 bit or 12 bit monochrome; 24 bit or 36 bit RGB color.

Operating Environment 10 %-80 % relative humidity/15E C - 30E C  ambient

Lens Mount Nikon “F” bayonet mount (adapters available for almost all  new and older microscopes)

Computer Interface PCI plug-in card (supplied)

Operating Systems Windows 95 and Windows NT 4.0 (Mac Power PC is forthcoming)

Computer Hardware
Requirements

Pentium or Pentium II required (166 Mhz or faster recommended)
64 Mb RAM required, 128 Mb recommended.
A video card that provides 24 bit RGB (millions of colors) at the desired monitor resolution
(8 Mb VRAM required for recommended 21” monitor operating at 1600 x 1200 resolution)

Software (included with
the camera)

The SPOT software environment includes: auto or manual exposure (80 ms to 17
minutes per color); white balance; image editing functions; image annotation; an image
archiving database; and a TWAIN driver.  An Image Pro driver is available at additional
cost.

Image Capture Time
(to monitor)

11 seconds for a 24 bit RGB image (Pentium II 333)
(SPOT and SPOT 2)

6 seconds for a 24 bit RGB
image (Pentium II 333)
(SPOT Jr.)

Fast Focus 4 subframes per second (typical)

File Size (24 bit RGB) 4.1 Mb (SPOT and SPOT 2) 1.2 Mb (SPOT Jr.)

External Shutter Control BNC connector on PCI plug-in board.
TTL level output for shuttering fluorescence illuminator.  TTL level is high when the
shutter is open, low when it is closed.

Power Supply Factory configurable to 100V, 120V, 220V or 230/240V; 50/60 Hz
Dimensions: 5.0"H x 10.5" W x 8.0" D
Weight:  12 lbs.

Camera Head Dimensions:  5.0"H x 7.0"W x 7.25"D

Weight:  7 lbs.
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Introduction
After a period of time, depending on camera use and ambient humidity levels, the
desiccant in the camera head can become saturated with moisture and lose its
effectiveness.  At this point, frost will start to form on the chip and image quality will
deteriorate.  Fortunately, changing the desiccant is easy and relatively inexpensive.  You
can either do it yourself, or arrange for Diagnostic Instruments to do it for you.

Do It Yourself Steps

Follow these steps to change the desiccant in your SPOT camera.

1. Contact Diagnostic Instruments and order a desiccant changing kit (P/N SP700-
100). This kit contains a jar of desiccant packets, tweezers, a 3/8” allen wrench, and a
roll of Teflon tape.

2. Remove the camera from the microscope.
Follow these steps:

a) Turn off your computer and the SPOT power supply.

b) Disconnect both the computer cable and the power supply cable from the SPOT
camera head.

c) Disconnect the camera head from the microscope coupler.

d) Attach the plastic lens cap to the front of the camera.

3. Pick a non-drafty, non-dusty, non-humid work environment.
An air-conditioned office is usually good.

4. Use the 3/8” Allen wrench to unscrew the large silver plug on the side of the
camera.  Turn the screw counter-clockwise.

5. Remove the old desiccant.
Use the tweezers to pluck the old desiccant packet out of the hole.

6. Install the new desiccant.
Before dropping the packet into the hole, push in the ends of the packet; this causes
the ends to “pucker” and the packet to assume a cylindrical shape.  Try to minimize
the amount of time between opening the jar and re-sealing the camera.

7. Replace the Teflon tape on the silver plug.
Remove all of the old Teflon tape from the threads on the plug.  Carefully wrap three
layers of new Teflon tape around the plug threads (don’t look for a sticky side to this
tape, there is none).  After the first layer is wrapped on, apply some tension to the
tape while winding so that the tape conforms to the shape of the threads.
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8. Screw the silver plug back into the camera.
Using your fingers, gently start screwing the silver plug back into the camera head,
turning clockwise.  Once the threads are started and the Teflon tape is smoothly
turning with the plug, use the 3/8” Allen wrench to finish tightening the plug.
Tighten it well to ensure a good seal.

9. Place the camera back on the microscope.  Follow these steps:

a) Remove the plastic lens cap from the front of the camera.

b) Attach the camera head to the microscope coupler.

c) Ensure that both your computer and the SPOT power supply are turned off.

d) Connect the computer cable and the power supply cable to the SPOT camera
head.

! Note:  For a more detailed explanation of installing your SPOT camera, refer to
the box insert that was included with your camera.
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Introduction
The SPOT software is equipped with TWAIN functionality, which allows you to use
other image editing programs (i.e., Photoshop) to view and edit images that were initially
captured with the SPOT software.  In this way, you can make use of the image editing
programs and features that you are familiar with in conjunction with SPOT’s image
capture capabilities.  The following section details how TWAIN compatibility allows you
to open and edit a SPOT image in Photoshop.

! Note:  Adobe Photoshop was selected as the example to illustrate SPOT’s TWAIN
features because it is one of the most commonly used “TWAIN capable” image
editing programs.

Using SPOT with Photoshop

TWAIN capability allows you to open an interface between the SPOT software and any
other TWAIN capable image editing program.  This allows for the following:

§ You can open and edit a SPOT image in Photoshop.

§ You can use SPOT to capture an image from within Photoshop.

§ Captured images can be transferred into Photoshop for editing.

To capture an image from within Photoshop, follow these steps:

1. Open Photoshop.

2. Define the source of the program that you want to interface with (i.e., in this case the
SPOT software).  From the File menu, select Acquire and TWAIN-32 Source.  The
Select Source window appears:

3. Select the Spot Camera (32-bit) option, and click on the Select button.  The SPOT
software is now the default TWAIN source.
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4. From the File menu in Photoshop, select Acquire and TWAIN_32.  The Spot Camera
window appears within Photoshop, as shown here:

5. At this point you have several options.

− You can select or modify the image setup that you want to use to capture an
image.

− You can perform a variety of pre - image capture operations.

− You can capture an image in three different ways.

Each of these options is discussed in the sections that follow.

Image Setups

From the Spot Camera window, you can define new image setups, and modify or delete
existing setups.

§ To define a new image setup, click on the Add button.

§ To modify the current image setup, click on the Modify button.
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§ To delete an image setup, select the image setup from the list, and click on the Delete
button.

! Note:  The process of defining an image setup is discussed in Chapter 3, Preparing
to Take a Picture.

Pre - Image Capture Operations

In addition to adding and modifying image setups, you can perform a variety of image
capture operations from the Toolbar that appears at the left of the window.  These
operations are identical in function to those in the stand-alone version of the SPOT
program.

§ Focus
§ Frame
§ Compute Exposure
§ Recall Previous Exposure

! Note:  The Toolbar button for the Recall Previous Exposure option does not appear
on the Toolbar of the stand-alone version; it appears only as an option on the
Camera menu.

§ Compute White Balance Values
§ Set Image Region
§ Get Background Image
§ Get Flatfield Image

! Note:  These options are discussed in detail in Chapters 3 and 4.

Image Captures

From the SPOT/Photoshop interface, you can capture an image in two different ways.
You can either preview the image and then transfer it to Photoshop, or you can Acquire
the image, which sends the captured image directly to Photoshop.

§ Preview – To capture an image in preview mode, click on the Preview button.  The
SPOT camera captures the image (as described in Chapter 4) and opens in the Spot
Camera window within Photoshop.

§ Transfer - After you have captured an image using the Preview option, you can
transfer it to Photoshop, where it can be edited and saved.  To transfer a preview
image, click on the Transfer button.

§ Acquire - As an alternative to previewing and transferring images, you can capture
images and have them automatically open in Photoshop.  To do this, click on the
Acquire button.



Appendix C Using SPOT's TWAIN Features

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 140

The Keep Window on Top option allows you to preview and transfer or acquire multiple
images without having to re-open the SPOT window.

§  If the Keep Window on Top box is checked, the SPOT window remains open.

§ If the box is not checked, the SPOT window automatically closes after each image is
transferred or acquired.



Appendix D Using the SPOT Image Pro Plus Driver

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 141

Appendix D: Using the SPOT Image Pro Plus
Driver

Introduction ...................................................................................................... 142

Installing the SPOT Image Pro Plus Driver................................................... 142

Using the Driver to Work in Image Pro ......................................................... 142



Appendix D Using the SPOT Image Pro Plus Driver

User's Guide to the SPOT Cooled Color Digital Camera, 6/9/98 142

Introduction
The SPOT Image Pro Plus driver allows users to acquire 24 bit color and 8 bit or 12 bit
monochrome images within Image Pro Plus.  The driver provides all of the image capture
features that are available through the SPOT stand alone software.

! Note:  Refer to Chapter 3, Preparing to Take a Picture and Chapter 4, Taking a
Picture for details on the image capture features in the SPOT software.

Installing the SPOT Image Pro Plus Driver

To install the SPOT Image Pro Plus driver, follow these steps:

1. If you have not already done so, install version 2.1 of the SPOT stand alone software.

2. Ensure that the serial number of the SPOT camera/software matches the serial
number on the Image Pro Driver disk.  To check the serial number, click on the Help
menu in the SPOT software.

3. Copy the two files from the SPOT Image Pro Plus floppy disk into the Image Pro Plus
32 bit directory.

! Note: The driver will not work with the 16 bit version of Image Pro Plus.

Using the Driver to Work in Image Pro

Follow these steps to use the SPOT Image Pro Plus driver.

1. Open the Image Pro Plus program.

2. From the Acquire menu, select the Video/Digital option.

3. Click on the Setup tab.

4. Select the SPOT driver from the list of Current Drivers.

5. After you have selected the SPOT driver, click on the Configure button. The SPOT
Image Setup window opens.

6. Enter the Image Setup options .

! Note: Refer to Chapter 3, Preparing to Take a Picture for more information on
entering information in the Image Setup window.  The window works in the same
way as the stand alone version.  You can also access Image Setups that were
created in the stand alone version of the SPOT software by clicking on the Load
Settings button.
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7. Click on OK.

8. To capture an image, follow steps nine through 13.

9. Press the Start Preview button.  The SPOT Camera window appears as shown here:

10. Click on the Preview button to capture a preview image.

Before and after you capture an image, you can use the SPOT Toolbar buttons to
perform the following pre and post exposure measurements and adjustments:

− focus
− frame
− compute exposure values
− white balance
− flatfield correction
− background subtraction
− region of interest selection

! Note: Refer to Chapter 3 and Chapter 4 for more information on using these
options.

11. If you want to change the Image Setup that you will use to capture the image, click on
the Modify button.  The Image Setup window appears.  Enter any adjustments that
you want, and click on OK to close the Image Setup window.

12. Either press Preview to re-preview the image with the new settings, or click on the
Close button to return to the Acquire, Video/Digital window.
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13. Click on Snap to take the picture.  The image appears in Image Pro Plus.

! Note: Refer to the Image Pro Plus manual for more information on the Acquire
Video/Digital window options and other image editing information.


